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Notice on Export Controls. The technical data and technology inherent in this
Document may be subject to U.S. export control laws, including the U.S. Export
Administration Act and its associated regulations, and may be subject to export or
import regulations in other countries. Reader agrees to comply strictly with all such
regulations and acknowledges that Reader has the responsibility to obtain licenses to
export, re-export, or import the Document and any Compliant Products.

Equipment warranty

The term of guarantee of normal operation of the storage system and free service is
one year from date of purchase.

If a failure occurs multiple times, the storage system might shut off to avoid a serious
accident.

Backup

Hitachi cannot guarantee against data loss due to failures. Therefore, back up your
data to minimize chances for data loss.

Data backup is also critical when hardware components are added or replaced,
because performing such hardware procedures restores parameter settings that can
affect how data is managed on the storage systems.

Disposal

 

 
This symbol on the product or on its packaging means that your electrical and
electronic equipment should be disposed at the end of life separately from your
household wastes.

There are separate collection systems for recycling in the European Union. For more
information, contact the local authority or the dealer where you purchased the
product.

UEFI Development Kit 2010

This product includes UEFI Development Kit 2010 written by the UEFI Open Source
Community. For more information, see the UEFI Development Kit website:

http://sourceforge.net/apps/mediawiki/tianocore/index.php?title=UDK2010

© 2004, Intel Corporation.

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of the Intel Corporation nor the names of its contributors might be
used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Preface
Before you install a Hitachi Virtual Storage Platform (VSP) storage system, it
is important to confirm that your site is ready to support your storage
system.

This guide describes how to plan and prepare for the installation of a Hitachi
VSP storage system.

As part of the site-preparation process, customers are required to purchase
site-preparation services from Hitachi Global Services. These services
include:
• A telephone predelivery site survey to confirm power, location of

equipment, access, and expectations.
• Telephone consultation to determine a customer's optimum configuration.

□ Safety and environmental notices

□ General safety guidelines

□ Audience and qualifications

□ Product version

□ Release notes

□ Document conventions

□ Conventions for storage capacity values

□ Accessing product documentation

□ Getting help

□ Comments
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Safety and environmental notices

Equipment warranty

The term of guarantee of normal operation of the storage system and free
service is one year from date of purchase.

If a failure occurs multiple times, the storage system might shut off to avoid
a serious accident.

Notice of export controls

Export of technical data contained in this document might require an export
license from the United States government, the government of Japan. or
both. Contact the Hitachi Legal Department for guidance about any export
compliance questions.

Backup

Hitachi cannot guarantee against data loss due to failures. Therefore, back up
your data to minimize chances for data loss.

Data backup is also critical when hardware components are added or
replaced, because performing such hardware procedures restores parameter
settings that can affect how data is managed on the storage systems.

Disposal

 

 
This symbol on the product or on its packaging means that your electrical
and electronic equipment should be disposed at the end of life separately
from your household wastes.

There are separate collection systems for recycling in the European Union.
For more information, contact the local authority or the dealer where you
purchased the product.

UEFI Development Kit 2010

This product includes UEFI Development Kit 2010 written by the UEFI Open
Source Community. For more information, see the UEFI Development Kit
website:
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© 2004, Intel Corporation.

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

Neither the name of the Intel Corporation nor the names of its contributors
might be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

General safety guidelines
Before starting maintenance:
• Maintenance must be performed by trained and qualified engineers only.
• The safety guidelines and procedures in this manual must be read and

followed.
• In this manual and on the storage system, hazard warnings are provided

to aid you in preventing or reducing the risk of death, personal injury, or
product damage. Understand and follow these hazard warnings fully.

• If warning labels on the storage system become dirty or start peeling off,
replace them.

• If an anomaly such as an unusual noise, smell, or smoke occurs on the
storage system while it is running, power off or remove the power cables
immediately.
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• Hazard warnings in this manual or on the storage system cannot cover
every possible case, because it is impossible to predict and evaluate all
circumstances beforehand. Be alert and use common sense.

• To ensure normal operation, operate the storage system according to the
information in this manual.

Read the following safety guidelines carefully and follow them when you
conduct maintenance of the machine:
• Do not use materials that are outside the specifications for the storage

system.
• Use the spare parts, consumables, and materials for maintenance that are

specified in this manual; otherwise, personal injury, system damage, and
degradation in system quality can occur.

• Keep the maintenance area neat.
• Always put away parts, materials, and tools when not in use.

Handling of heavy parts
• When lifting a heavy object, hold it close to yourself and keep your back

erect to prevent back injury.
• When lifting an object designated with a caution in this manual, use a

proper lifting tool or have somebody assist you.

Preventing electric shock
• Before starting work, be sure that, unless otherwise specifically instructed,

there is no potential electric hazard in the maintenance area such as
insufficient grounding or a wet floor.

• Before starting work, know where the emergency power-off switches are
located and be sure you know how to operate them.

• Unless otherwise specifically instructed, remove all power sources to the
machine before starting maintenance. Switching off the storage system
power supplies is usually not sufficient.

• Do not touch any uninsulated conductor or surface that remains charged
for a limited time after the external power supply to the storage system is
disconnected.

• Do not replace parts during a thunderstorm.

Avoiding rotating or moving parts
• Do not supply power to any device with rotating or moving parts that are

not properly covered.
• Tuck in your tie, scarf, shirt, or any other loose clothing to prevent it from

getting caught by a rotating or moving part.
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Preventing machine damage
• Use the tools and instruments, as instructed in this manual, or equivalent

commercially available tools and instruments suited for the purpose.
• Use measurement instruments and powered tools that are properly

calibrated or periodically inspected.
• Before finishing your work, be sure all parts removed during maintenance

have been installed in their original positions in the storage system. Do not
leave any tools or foreign material in the storage system.

Working when the storage system is turned on
Observe the following safety measures when working on the storage system
with the system power turned on. When you perform maintenance, do not
touch live electric parts to prevent an electric shock.
• Do not touch heat sinks immediately after a board is removed because the

heat sinks are extremely hot.
• While performing maintenance, do not drop tools, screws, or other items

into the storage system, because doing so can cause a short circuit.
• While performing maintenance, do not damage or pinch wires.
• When moving a heavy object, have at least two people move the object

after confirming there are no obstacles nearby.

Precautions when using the storage system
• Use the supplied power cords included with the storage system. Do not

use the supplied power cords for other products. Do not use other power
cords with the storage system.

• Shut off the power feed to the equipment and inform the system
administrator immediately if you notice an unusual smell, abnormal heat
generation, or smoke emission. Leaving such conditions unattended can
cause electric shock or fire.

• Exercise care when handling the storage system and its parts. Do not drop
the equipment or parts.

• Do not stand on the storage system. Avoid using the storage system for
any use other than the one for which it was originally designed.

• Do not place heavy objects on the storage system, near the vents on the
front and rear panels, or on the cables attached to the storage system.

• Do not put a container with water, paper clips, or the like on the storage
system or near the power supply.

• Route cables in a way to prevent people from tripping over them.
• Do not operate the storage system in a moist or dusty place.
• Keep these vents open and be sure they are not blocked to keep the

storage system ventilated. Cool air enters the storage system from the air
vent on the front panel and exits through the vent on the rear panel.
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• If a failure occurs in the storage system, follow the instructions in this
manual. If the problem is not covered by this manual, contact your system
administrator.

Procedures in an emergency

For electric shock

• Before performing maintenance, be sure that there is no potential electric
hazard in the maintenance area, such as insufficient grounding or a wet
floor.

• Before performing maintenance, observe where the emergency poweroff
switches are located and be sure you know how to operate them.

• Unless otherwise instructed, remove all power sources to the storage
system before starting work. Switching off the storage system power
supplies is not sufficient. When power is fed from a wall or floor outlet,
unplug the power supply cord, or turn off the switch on the power
distribution panel or board.

• If the power supply has a lockout device, lock the device after powering off
the storage system and retain the key. Attach a notice on the panel or
board prohibiting the use of the switch.

• If the machine power has been already turned off, confirm that these
conditions have been satisfied.

For fire

• Shut off all the power to the machine.
• Turn off the emergency power switch or stop the power supply to the

storage system.
• If the fire continues to burn after the power is shut off, take suitable

actions, including the use of a fire extinguisher, or call the fire department.

Audience and qualifications
This guide is intended for data center administrators, facility managers, and
others who perform the planning and preparation work for storage system
installations. It references skilled tasks and describes important safety
considerations, and is not intended as a training aid for untrained personnel.

The information in this guide assumes the reader has the following abilities:
• Is familiar with computing terminology, RAID technology, and optical and

Ethernet connectivity.
• Understands networking concepts, network switch technology, and

network cabling.
• Knows how to calculate floor loads and power budgeting.
• Understands the procedures for installing rack-mounted components and is

trained in safe work procedures.
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• Is familiar with high-speed interconnects for modular storage systems.

Product version

This document revision applies to Hitachi Virtual Storage Platform G200,
G400, G600 firmware 83-01-0x or later.

Release notes
Read the release notes before installing and using this product. They may
contain requirements or restrictions that are not fully described in this
document or updates or corrections to this document.

Document conventions
This document uses the following typographic conventions:

Convention Description

Bold Indicates text on a window, other than the window title, including menus,
menu options, buttons, fields, and labels. Example: Click OK.

Italic Indicates a variable, which is a placeholder for actual text provided by the
user or system. Example: copy source-file target-file

Note: Angled brackets (< >) are also used to indicate variables.

Monospace Indicates text that is displayed on screen or entered by the user. Example:
pairdisplay -g oradb

< > angled brackets Indicates a variable, which is a placeholder for actual text provided by the
user or system. Example: pairdisplay -g <group>

Note: Italic font is also used to indicate variables.

[ ] square brackets Indicates optional values. Example: [ a | b ] indicates that you can choose a,
b, or nothing.

{ } braces Indicates required or expected values. Example: { a | b } indicates that you
must choose either a or b.

| vertical bar Indicates that you have a choice between two or more options or arguments.
Examples:

[ a | b ] indicates that you can choose a, b, or nothing.

{ a | b } indicates that you must choose either a or b.

This document uses the following icons to draw attention to information:
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Icon Label Description

Note Calls attention to important or additional information.

Tip Provides helpful information, guidelines, or suggestions for performing
tasks more effectively.

Caution Warns the user of adverse conditions or consequences (for example,
disruptive operations).

WARNING Warns the user of severe conditions or consequences (for example,
destructive operations).

Conventions for storage capacity values
Physical storage capacity values (for example, disk drive capacity) are
calculated based on the following values:

Physical capacity unit Value

1 kilobyte (KB) 1,000 (10 3) bytes

1 megabyte (MB) 1,000 KB or 1,0002 bytes

1 gigabyte (GB) 1,000 MB or 1,0003 bytes

1 terabyte (TB) 1,000 GB or 1,0004 bytes

1 petabyte (PB) 1,000 TB or 1,0005 bytes

1 exabyte (EB) 1,000 PB or 1,0006 bytes

Logical storage capacity values (for example, logical device capacity) are
calculated based on the following values:

Logical capacity unit Value

1 block 512 bytes

1 KB 1,024 (210) bytes

1 MB 1,024 KB or 1,0242 bytes

1 GB 1,024 MB or 1,0243 bytes

1 TB 1,024 GB or 1,0244 bytes

1 PB 1,024 TB or 1,0245 bytes

1 EB 1,024 PB or 1,0246 bytes
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Accessing product documentation
Product user documentation is available on the Hitachi Data Systems Portal: 
https://portal.hds.com. Check this site for the most current documentation,
including important updates that may have been made after the release of
the product.

Getting help
Hitachi Data Systems Support Portal is the destination for technical support
of your current or previously-sold storage systems, midrange and enterprise
servers, and combined solution offerings. The Hitachi Data Systems customer
support staff is available 24 hours a day, seven days a week. If you need
technical support, log on to the Hitachi Data Systems Support Portal for
contact information: https://portal.hds.com.

Hitachi Data Systems Community is a new global online community for HDS
customers, partners, independent software vendors, employees, and
prospects. It is an open discussion among these groups about the HDS
portfolio of products and services. It is the destination to get answers,
discover insights, and make connections. The HDS Community complements
our existing Support Portal and support services by providing an area where
you can get answers to non-critical issues and questions. Join the
conversation today! Go to community.hds.com, register, and complete your
profile.

Comments
Please send us your comments on this document to doc.comments@hds.com.
Include the document title and number, including the revision level (for
example, -07), and refer to specific sections and paragraphs whenever
possible. All comments become the property of Hitachi Data Systems
Corporation.

Thank you!
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1
Verifying component failures

This chapter describes how to use the maintenance utility to confirm
component failures.

□ Replaceable parts

□ Identifying hardware faults
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Replaceable parts
The following list shows the components that you can replace on site for the
storage systems.

Note: For the dense intermix drive tray, the only user-replacement procedure
supported by Hitachi is installing or replacing disk drives.

• Drive (replacing drives on the flash module drive tray is not supported)
• Battery
• Fan for CBSS or CBSL
• Power supply unit
• Controller
• Cache memory
• Front end module
• Small Form-Factor Pluggable
• Back end module for CBLM or CBLH
• ENC
• SAS cable
• Cache Flash Memory
• LAN blade
• Backup Module (BKM) for CBSS or CBSL
• Backup Module (BKMF) for CBLM or CBLH

Identifying hardware faults
There are several ways the storage system can alert you to failures:
• When notified about an error by email, the maintenance utility, or the

Simple Management Network Protocol (SMNP).
• When a failure is indicated by storage system LED (for example, WARNING

or ALARM LED goes on or READY LED does not go on).

To identify a failed part and recover the storage system:

Procedure

1. Check the serial number of the storage system referenced in the email
notification or SNMP alert.

2. Start the maintenance utility (see Starting the maintenance utility).
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3. In the Maintenance Utility window, check the serial number of the
storage system where the error was reported.
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4. In the left pane of the Maintenance Utility window (circled in the figure
below), check the Status of the storage system.
 

 

Status Description Navigation area

Failed The storage system might be

down.

 

 

Warning The part status might have a

Blocked, Failed, or Warning

status.

 

 

Information Check the status of

unimplemented SIMs,

regardless of part status.

 

 

Ready All parts have a normal

status.

 

 

Power-on in progress Power-on is in progress.  
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Status Description Navigation area

Power-off in progress Power-off is in progress.  

 

(Other than shown above) Power-off status  

 

5. At the top-right of the Maintenance Utility window, click Alert.
The window switches to the Alerts tab.
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6. Click the Alert ID.
The Alert Detail window shows the failed part that must be replaced.
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7. Click Action Code to confirm the replacement procedure.

Note: If SEE MANUAL appears under Location in the Alert
Detail window, contact the HDS Portal to have an authorized
person make the repair: https://portal.hds.com.
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8. When the Recovery Procedure window appears, check the failed part
and order a replacement for that part.
The following window shows an example of a drive failure

 

 
In this example:
• Drive = location of the drive in the drive tray.
• DB = number of the drive tray.

The following table describes the possible status conditions.

Status Description

Normal Normal status.

Warning A part failed or is being affected by a failure

somewhere else in the storage system. The

status changes to Normal after the part is

replaced.
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Failed A part failed.

Blocked A part has become blocked. Use the

maintenance utility to identify the problem

and replace the part if necessary.

Not fix SFP Status-limited

Undetermined status.

Warning (Port n failed) Drive Status-limited

Drive port n is in a failed status.

Copying n % (TYPE to DRIVE) Drive Status-limited

Copying is in progress.
• n = copy-progress rate.
• TYPE= Correction copy, Copy back,

Dynamic sparing, or Drive copy.
• DRIVE = copy destination drive location. If

the drive is a copy destination drive in
Correction copy, DRIVE appears as this
Drive.) If multiple copy statuses exist, a
line break is added to every copy status
line, and then the information is
displayed.

Copying n % (TYPE from DRIVE) Drive Status-limited

Copying is in progress.
• n = copy-progress rate.
• TYPE = Copy back, Dynamic sparing, or

Drive copy.
• DRIVE = copy source drive location If

multiple copy statuses exist, a line break
is added to every copy status line, and
then the information is displayed.

Pending (TYPE to DRIVE) Drive Status-limited

Copying is in a suspended status.
• TYPE = Correction copy, Copy back,

Dynamic sparing, or Drive copy.
• DRIVE = copy destination drive location. If

the drive is a copy destination drive in
Correction copy, DRIVE appears as this
Drive.) If multiple copy statuses exist, a
line break is added to every copy status
line, and then the information is
displayed.

Pending (TYPE from DRIVE) Drive Status-limited

Copying is in a suspended status.
• TYPE = Copy back, Dynamic sparing, or

Drive copy.
• DRIVE = copy source drive location If

multiple copy statuses exist, a line break
is added to every copy status line, and
then the information is displayed.
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Copy incomplete Drive Status-limited

Data-copy operation is not complete.

Reserved Drive Status-limited

Spare drive has an usable status.
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2
Hardware description

This chapter provides a tour of the storage system hardware.

□ Storage system controllers

□ Controller interfaces

□ Storage system drive trays

□ Service Processor
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Storage system controllers
Every storage system has two controllers. The controllers contain fans and
power supplies, and provide the interfaces between a host and the storage
system.

A controller manages the I/O between the host system and data volumes.

CBSS controller

CBSS with front panel bezel

 

 

Number Item Description

1 POWER LED Green: storage system is
powered on.

Amber: storage system is
receiving power.

2 READY LED Green: normal operation.

3 WARNING LED Off: normal operation.

Amber: component requires
maintenance.

Blink: failure requires
maintenance.

LED might go OFF during user
maintenance.

4 ALARM LED Off: normal operation.

Red: processor failure (system
may be down). See the HDS
Support Portal at https://
portal.hds.com

5 POWER ON/OFF (main switch) Powers the storage system.

6 Lock Locks and unlocks the front
panel bezel using the supplied
key.
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Note: Removing a controller can cause the POWER, READY, WARNING, and
ALARM LEDs on the front panel to go off. These LEDs return to their on state
after the storage system recovers from the controller replacement.

CBSS front panel without bezel

 

 

Number Item Description

1 ACT LED Green: normal operation.

Blink green: drive is being
accessed.

2 ALM LED Red: drive stopped due to a
failure and can be removed
safely.

3 POWER, READY, WARNING, ALARM
LEDs

See previous table.

4 POWER ON/OFF (main switch) Powers the storage system.

5 Small form factor drives Twenty-four 2.5-inch small form
factor drives oriented vertically.
Slots are designated
0-23 ,moving from left to right.

CBSS rear panel
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Number Item Description

1 Controllers Controller 1 (left) and
Controller 2 (right).

2 Front end module N/A

3  CTL ALM LED Red: controller can be
removed safely.

Blink red: failure with the
controller's power supply
unit.

Amber: LAN reset switch
was pressed.

4 BACKUP STTS LED Green: power restoration
in progress following
power outage.

Fast blink green: restoring.

Slow blink green: restoring
or sequential shutdown in
progress.

5 CTL WARN LED Amber blink one time:
failure with fan 0.

Amber blink two times:
failure with fan 1.

6 Cache flash memory N/A

7 LAN-RST switch Use only when instructed
by Hitachi Support.

8 LAN port Maintenance LAN port
(left) and user LAN port
(right).

9 Uninterruptible power supply port N/A

10 ALARM LED (for cache flash memory) Red: cache flash memory
can be removed safely.

11 Backup module N/A

12  STATUS Green: charging of the
battery in the backup
module is complete.

Blink green: battery in the
backup module is charging
or discharging.

Red: backup module can
be removed safely.

Blink red: backup module
can be removed safely.

Blink red one time: battery
failure
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Number Item Description

Off: battery is not
installed, failure occurred,
or firmware is being
upgraded.

13 SAS port N/A

14 Power supply unit N/A

CBSL controller

CBSL with front panel bezel
 

 

Number Item Description

1 POWER LED Green: storage system is
powered on.

Amber: storage system is
receiving power.

2 READY LED Green: normal operation.

3 WARNING LED Off: normal operation.

Amber: component requires
maintenance.

Blink: failure requires
maintenance.

LED might go OFF during user
maintenance.

4 ALARM LED Off: normal operation.

Red: processor failure (system
may be down). See the HDS
Support Portal at https://
portal.hds.com

5 POWER ON/OFF (main switch) Powers the storage system.

6 Lock Locks and unlocks the front
panel bezel using the supplied
key.
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Note: Removing a controller can cause the POWER, READY, WARNING, and
ALARM LEDs on the front panel to go off. These LEDs return to their on state
after the storage system recovers from the controller replacement.

CBSL front panel without bezel

 

 

Number Item Description

1 ACT LED Green: normal operation.

Blink green: drive is being
accessed.

2 ALM LED Red: drive stopped due to a
failure and can be removed
safely.

3 POWER, READY, WARNING, ALARM
LEDs

See previous table.

4 POWER ON/OFF (main switch) Powers the storage system.

5 Large Form Factor Drives Twelve 3.5-inch large form
factor drives stacked
horizontally. Slots are
designated the following way:

8   9   10  11
4   5   6   7
0   1   2   3

CBSL rear panel
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Number Item Description

1 Controllers Controller 1 (left) and
Controller 2 (right).

2 Front end module N/A

3  CTL ALM LED Red: controller can be
removed safely.

Blink red: failure with the
controller's power supply
unit.

Amber: LAN reset switch
was pressed.

4 BACKUP STTS LED Green: power restoration
in progress following
power outage.

Fast blink green: restoring.

Slow blink green: restoring
or sequential shutdown in
progress.

5 CTL WARN LED Amber blink one time:
failure with fan 0.

Amber blink two times:
failure with fan 1.

6 Cache flash memory N/A

7 LAN-RST switch Use only when instructed
by Hitachi Support.

8 LAN port Maintenance LAN port
(left) and user LAN port
(right).

9 Uninterruptible power supply port N/A

10 ALARM LED (for cache flash memory) Red: cache flash memory
can be removed safely.

11 Backup module N/A
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Number Item Description

12  STATUS Green: charging of the
battery in the backup
module is complete.

Blink green: battery in the
backup module is charging
or discharging.

Red: backup module can
be removed safely.

Blink red: backup module
can be removed safely.

Blink red one time: battery
failure

Off: battery is not
installed, failure occurred,
or firmware is being
upgraded.

13 SAS port N/A

14 Power supply unit N/A

CBLM controller

CBLM with front panel bezel
 

 

Number Item Description

1 POWER LED Green: storage system is
powered on.

Amber: storage system is
receiving power.

2 READY LED Green: normal operation.
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Number Item Description

3 WARNING LED Off: normal operation.

Amber: component requires
maintenance.

Blink: failure requires
maintenance.

LED might go OFF during user
maintenance.

4 ALARM LED Off: normal operation.

Red: processor failure (system
may be down). See the HDS
Support Portal at https://
portal.hds.com

5 POWER ON/OFF (main switch) Powers the storage system.

6 Lock Locks and unlocks the front
panel bezel using the supplied
key.

Note: Removing a controller can cause the POWER, READY, WARNING, and
ALARM LEDs on the front panel to go off. These LEDs return to their on state
after the storage system recovers from the controller replacement.

CBLM front panel without bezel
 

 

Number Item Description

1 POWER ON/OFF (main switch) Powers the storage system.

2 POWER, READY, WARNING, ALARM
LEDs

See previous table.
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Number Item Description

3 Controllers Controller 1 (top) and
Controller 2 (bottom).

4 Backup module N/A

5 BACKUP Green: power restoration in
progress following power
outage.

Fast blink green: restoring.

Slow blink green: restoring or
sequential shutdown in
progress.

6 Cache flash memory N/A

7 ALM LED (for cache flash
memory)

Red: cache flash memory can
be removed safely.

8  CTL ALM LED Red: controller can be removed
safely.

Blink red: failure with the
controller's power supply unit.

Amber: LAN reset switch was
pressed.

9 LAN-RST switch Use only when instructed by
Hitachi Support.

10  STATUS LED (for BKMF) Green: charging of the battery
in the backup module is
complete.

Red: backup module can be
removed safely.

Blink red one time: main
battery failure.

Blink red two times: backup
battery failure.

Blink red three times: both
batteries failed or preventive
maintenance replacement of
batteries can be performed.

Off: battery is not mounted,
battery-mounting failure
occurred, or firmware is being
upgraded. Off is normal status
for configurations with no
batteries (for example,
BKMF-10 and BKMF-20).

CBLM rear panel
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Number Item

1 Power supply unit

2 Front end module

3 Back end module

4 LAN blade

Controller interfaces
Controllers provide interfaces for connecting, powering, and configuring and
managing the storage system. They also have LEDs to show the status of the
storage system.

Front end module descriptions

8 Gbps Fibre Channel board LEDs and connectors
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Number Item Description

1 Fibre Channel connectors Connect to Fibre Channel
cables.

2 STATUS LED Green: front end module is in
power-on state.

Red: front end module can be
removed safely.

3 PORT LED Red: small form-factor
pluggable can be removed
safely.

Blue: normal link status at 8
Gbps.

Green: normal link status at 2
Gbps or 4 Gbps.

16 Gbps Fibre Channel board LEDs and connectors
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Number Item Description

1 STATUS LED Green: front end module is in
the power-on state.

Red: front end module can be
removed safely.

2 PORT LED Red: small form-factor
pluggable can be removed
safely.

Blue: normal link status at 16
Gbps.

Green: normal link status at 4
or 8 Gbps.

3 Fibre Channel connectors Connect to Fibre Channel
cables.

10 Gbps iSCSI board LEDs and connectors
 

 

Number Item Description

1 STATUS LED Green: front end module is in
the power-on state.

Red: front end module can be
removed safely.

2 PORT LED Red: small form-factor
pluggable can be removed
safely.

Blue: normal link status.
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Number Item Description

Blink blue: front end module is
in communication status.

3 iSCSI connectors Connect to Ethernet LAN
cables.

Back end module LEDs and connectors
 

 

Number Item Description

1 PATH 1 connector Connect to a drive tray.

2 PORT LED Blue: normal link status.

 

 

Number Item Description

1 STATUS LED Green: back end module is in
the power-on state.

Red: back end module can be
removed safely.
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Number Item Description

2 Port LED Blue: link status is normal.

3 PATH 0 connector Connect to a drive tray.

4 PATH 1 connector Connects to a drive tray.

Power supply unit LEDs and connectors
 

 

Number LED or connector Description

1 Receptacle Connect to the power cable
supplied with the storage
system.

2 AC IN LED Blue: AC input is normal.

3 ALM/RDY LED Red: power supply unit can be
removed safely.

Green: normal operation.

Power supply unit LEDs and connectors
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Number Item Description

1 ALM/RDY LED Red: power supply unit can be
removed safely.

2 Receptacle Connect to the power cable
supplied with the storage
system.

3 RDY LED Green: normal operation.

Storage system drive trays
Drive trays contain drives, power supplies, fans, and status LEDs. They also
provide interfaces for connecting to controllers and other drive trays.

Small form factor (SFF) drive tray

SFF with front panel bezel
 

 

Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber: Nonfatal error. Storage
system can remain operating.

This LED can also go ON to
identify the drive tray being
added.

4 Lock Locks and unlocks the front
panel bezel using the supplied
key.

SFF front panel without bezel
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Number Item Description

1 ACT LED Green: normal operation.

Blink green: drive is being
accessed.

2 ALM LED Red: drive stopped due to a
failure and can be removed
safely.

3 POWER, READY, LOCATE LEDs See previous table.

4 Small form factor drives Twenty-four 2.5-inch small form
factor drives oriented vertically.
Slots are designated
0-23 ,moving from left to right.

SFF rear panel
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Number Item Description

1 ENC N/A

2 POWER LED Green: ENC is in the power-on
state.

3 LOCATE LED Amber: Shows the ENC when
adding drive trays.

4 ALARM LED Red: ENC can be removed
safely.

5 PATH (IN) LED Blue: IN side port is linked up.

6 PATH (IN) connector Connect to a controller or drive
tray.

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 Console This port is reserved.

10 Power supply unit N/A

11 Receptacle Connect to the power cable
supplied with the storage
system.

12 AC IN LED Green: normal operation.

13 ALM LED Red: power supply unit can be
removed safely.

14 RDY LED Green: normal operation.

Large form factor (LFF) drive tray

LFF with front panel bezel
 

 

Number Item Description

1 POWER LED Green: Drive tray is powered
on.
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Number Item Description

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber: Nonfatal error. Storage
system can remain operating.

This LED can also go ON to
identify the drive tray being
added.

4 Lock Locks and unlocks the front
panel bezel using the supplied
key.

LFF front panel without bezel
 

 

Number Item Description

1 POWER, READY, LOCATE LEDs See previous table.

2 ACT LED Green: normal operation.

Blink green: drive is being
accessed.

3 ACT LED Red: drive stopped due to a
failure and can be removed
safely.

4 Large Form Factor Drives Twelve 3.5-inch large form
factor drives stacked
horizontally. Slots are
designated the following way:

8   9   10  11
4   5   6   7
0   1   2   3

LFF rear panel
 

Hardware description 49
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



 

Number Item Description

1 ENC N/A

2 POWER LED Green: ENC is in the power-on
state.

3 LOCATE LED Amber: Shows the ENC when
adding drive trays.

4 ALARM LED Red: ENC can be removed
safely.

5 PATH (IN) LED Blue: IN side port is linked up.

6 PATH (IN) connector Connect to a controller or drive
tray.

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 Console This port is reserved.

10 Power supply unit N/A

11 Receptacle Connect to the power cable
supplied with the storage
system.

12 AC IN LED Green: normal operation.

13 ALM LED Red: power supply unit can be
removed safely.

14 RDY LED Green: normal operation.

Flash module drive (FMD) tray

FMD with front panel bezel
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Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber: can be forced on using
the maintenance utility when
adding drive trays.

4 Lock Locks and unlocks the front
panel bezel using the supplied
key.

FMD front panel without bezel
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Number Item Description

1 ACT LED Green: normal operation.

Blink green: drive is being
accessed.

2 ALM LED Red: drive stopped due to a
failure and can be removed
safely.

3 POWER, READY, LOCATE LEDs See previous table.

4 Flash module drives Twelve flash module drives.
Slots are designated the
following way:

9, 10, 11

6, 7, 8

3, 4, 5

0, 1, 2

FMD rear panel
 

 

Number Item Description

1 ENC N/A

2 POWER LED Green: ENC is in the power-on
state.

3 LOCATE LED Amber: Shows the ENC when
adding drive trays.

4 ALARM LED Red: ENC can be removed
safely.

5 PATH (IN) LED Blue: IN side port is linked up.

6 PATH (IN) connector Connect to a controller or drive
tray.
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Number Item Description

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 Console This port is reserved.

10 Receptacle Connect to the power cable
supplied with the storage
system.

Dense intermix drive tray

Dense intermix drive tray with front panel bezel
 

 

Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber: Nonfatal error. Storage
system can remain operating.

This LED can also go ON to
identify the drive tray being
added.

4 Lock Locks and unlocks the front
panel bezel using the supplied
key.

Dense intermix drive tray display LEDs
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Number Item Description

1 ACT Green: normal operation.

Blink green: drive is being
accessed.

2 ALM LED Red: drive stopped due to a
failure and can be removed
safely.

Note: Drives are organized as follows, starting from the rear of the drive tray
and moving left to right. In the above figure on the left, the rear of the drive
tray is at the top.
• Rear of drive tray: 48 - 59
• 36 - 47
• 24 - 35
• 12 - 23
• Front of drive tray: 00 - 11

Dense intermix drive tray rear panel
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Number Item Description

1 Power supply unit N/A

2 RDY LED Green: normal operation.

3 AC IN LED Green: normal operation.

4 ALM LED Red: power supply unit can be
removed safely.

5 Receptacle Connect to the power cable
supplied with the storage
system.

6 ENC N/A

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 PATH (IN) LED Blue: IN side port is linked up.

10 PATH (IN) connector Connect to a controller or drive
tray.

11 Console This port is reserved.

12 ALARM LED Red: ENC can be removed
safely.

13 LOCATE LED Amber: Shows the ENC when
adding drive trays.

14 POWER LED Green: ENC is in the power-on
state.

Service Processor
Storage systems come with a separate, dedicated 1U service processor (SVP)
on which element manager runs. The SVP (model number 3919435.P)
operates independently from the storage system's CPU and operating system,
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and provides out‑of‑band configuration and management of the storage
system. It also collects performance data for key components of the storage
system to enable diagnostic testing and analysis.

Note: This product is also designed for IT power distribution systems with
phase-to-phase voltage.

The SVP runs Microsoft Windows Embedded Standard 7. This operating
system provides the same look and feel and desktop environment as
Microsoft Windows 7 Professional.

The SVP provides four RJ-45 ports:
• Two ports connect to the storage system controllers (one port for each

controller).
• One port connects to the user's IP network.
• One port connects to a user-supplied management console PC.

Three of the four RJ-45 ports (the ones that connect to the controllers and
the IP network) are configured as a bridge. The SVP can be addressed using
the default IP address 192.168.0.15.

Users are responsible for adopting the appropriate security procedures with
the SVP, including:
• Applying Windows security patches.
• Turning on automatic Windows updates or using the manual Windows

update method.
• Installing antivirus software that has been tested and approved by Hitachi.
• Installing the latest SVP firmware releases from Hitachi.

SVP front panel
The SVP front panel has LEDs, a reset button, and a power button.
 

 

Number Description

1 LEDs. From left to right, the LEDs are:
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Number Description

• BMC Heartbeat
• LAN card 2
• LAN card 1
• Hard drive
• System standby power

2 Reset button.

3 Power button. Applies power to or removes
power from the SVP.

SVP rear panel
The only ports used on the rear panel of the SVP are the power socket and
the four LAN ports.

 

 

Number Description

1 Power socket. Attach the power cable supplied
with the SVP.

2 Four LAN ports arranged as follows:

LAN3 LAN4

LAN1 LAN2

These ports connect to your IP network, the
management console PC, and the user LAN port
on each storage system controller.
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3
Replacing components

This chapter describes the steps to take before replacing a component. It also
describes how to check that the system has recovered after replacing
components.

□ Electrostatic discharge precautions

□ Unpacking replacement components

□ Follow appropriate power on and power off work procedures

□ Safety considerations

□ Guidelines to follow when replacing a component

□ Guidelines to follow after replacing a component

□ Starting the maintenance utiility

□ Replacement parts

□ Removing and replacing the front bezel

□ Checking recovery after replacing components
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Electrostatic discharge precautions
Static electricity can damage the storage system’s static-sensitive
components. To prevent damage, follow these precautions:

When performing the service procedures in this document, observe the
following electrostatic discharge (ESD) precautions:
• Wear an antistatic wrist strap at all times when handling any field-

replaceable unit (FRU). Clip the end of the wrist strap to exposed metal on
frame. For convenience, a wrist strap is supplied with the storage system.
Do not remove the wrist strap until the removal or replacement procedure
has been completed.

• Before handling any FRU, discharge any static electricity by touching a
grounded surface. Grounded surfaces include static-dissipating mats
(already grounded) or grounded workstations.

• Remove all plastic, vinyl, and foam material from the work area.
• Do not remove a FRU from its antistatic protective bag until you are ready

to install it.
• Handle any card FRU only by its edges and avoid touching the components

or circuitry.
• Do not slide a FRU over any surface.
• Limit body movement (which builds up static electricity) during the

removal and replacement of a FRU.
• To avoid electric shock when performing a “hot replacement” of a part, do

not wear metallic accessories or a watch and avoid touching “live” parts of
the storage system with a screwdriver or similar tools.

Unpacking replacement components
Unpack replacement components in a dry location that is not exposed to
moisture, direct sunlight, dust, and temperature extremes. If the part to be
added has been exposed to high or low temperature during transport, the
part might not operate properly.

Follow appropriate power on and power off work
procedures

If a replacement procedure requires power off and power on steps, follow the
steps carefully to ensure the security of data.

After powering off the storage system, remove the power cables from the two
power supply units on the storage system.
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Safety considerations
Observe the following guidelines to ensure safety when replacing parts.
Failure to follow these guidelines could result in bodily injury or damage to
the chassis or components.

• Use the host to back up user data on the storage system before replacing
components.

• When performing any installation, comply with all local health and safety
requirements.

• Wear protective footwear when moving storage system hardware.
• Do not wear loose clothing that could get caught in the chassis or

mounting hardware. Fasten ties and scarves and roll up sleeves.
• Wear safety glasses when working under conditions that are hazardous to

your eyes.
• Keep walkways clear of tools, cables, and parts to prevent them from

being stepped on or causing people to trip and fall.
• Do not work on the equipment or disconnect cables during a

thunderstorm, when wearing a wool sweater or other heavy wool clothing,
or when power is applied.

• Always turn off the storage system and unplug all data and power cables
before lifting the storage system.

• Keep floors dry to prevent slips and falls.
• Do not use ungrounded power cables.
• Use only the power cables supplied with this product. Do not use power

cables from other products. Otherwise, unexpected failures or accidents
can occur.

• If you encounter unusual odors, heat generation, or smoke emission, shut
off power to the equipment and inform the appropriate personnel Leaving
such conditions unattended can cause electric shock or fire.

• Keep the area clean and dust-free when replacing components.
• Do not block or cover the openings of the storage system hardware. Never

place a unit near a radiator or heat register. Failure to follow these
guidelines can cause overheating and affect the unit’s reliability.

• After a component has been replaced, secure the chassis cover to the
storage system. The chassis is designed to let cooling air flow effectively
within it. An open chassis allows air leaks that might interrupt and redirect
the flow of cooling air from internal components.

• Do not make mechanical or electrical modifications or repairs to the
equipment. Such actions can cause an electric shock or cause the storage
system to malfunction. Hitachi is not responsible for regulatory compliance
of a modified Hitachi product.

• When removing cables, hold the cable connector and leave enough slack in
the cables, so they do not bend to a diameter of less than 76 mm (3") or a
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radius less than 38 mm (1.5") when extended and do not become pinched
when retracted.

Guidelines to follow when replacing a component
Observe the following guidelines when replacing a component.

• Use only the replacement parts specified in this guide.
• Do not perform maintenance when the storage system is being started,

Wait for the READY LED on the controller to go on before performing
maintenance.

• If you replace a drive, controller, cache memory, front end module, backup
module, back end module, ENC, fan, or power supply unit while the
storage system power is turned on:
○ Wait at least 20 seconds after the failed part was removed before

installing the new part.
○ Complete the replacement within 10 minutes. Otherwise, the system

might power off due to an abnormal rise in temperature.

If a power supply unit and another component fail at the same time,
replace the power supply unit first, and then replace the other failed
component. Otherwise, the system might power off due to an abnormal
rise in temperature.

• If a fan on the controller fails at the same time when another component
fails, replace the fan first, and then replace the other failed component.
Otherwise, the system might power off due to an abnormal rise in
temperature.

• Insert replacement parts quickly. Otherwise, the recovery might fail.
• If only the main switch power is off, power is provided by the basic supply.

Do not leave components removed from the storage system for long
periods of time, as this can trigger a power supply alarm.

• If the replacement part has a cover over one or more connectors, replace
the cover of the connector part that is going to be used.

Guidelines to follow after replacing a component
Observe the following guidelines after replacing a component in the Hitachi
storage system.
• When restarting the storage system, wait for the amber POWER LED to go

ON, and then turn off the main switch. Wait at least one minute before
turning on the main switch.

• After you replace components, close all the external storage system
covers.
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Starting the maintenance utiility
You can start the maintenance utility from Hitachi Command Suite or Hitachi
Device Manager - Storage Navigator.

Starting the maintenance utility from Hitachi Command Suite

Procedure

1. Start Hitachi Command Suite.

 

 
2. In the Hitachi Command Suite main window, click the Resources tab,

and then click Storage Systems from the tree view.
3. Expand the tree, and then right-click a storage system and click Other

Functions.
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4. In Hitachi Device Manager - Storage Navigator, click the Maintenance
Utility menu, and then click Hardware to start the maintenance utility.
 

 

Starting the maintenance utility from Hitachi Device Manager -
Storage Navigator

Procedure

1. Launch a web browser from the console PC connected to the SVP, and
then start Device Manager - Storage Navigator.

2. Enter the following URL in the address field of your browser, and then
press the Enter key: http://[IP address of SVP]/module/sn2/0/
index.do

3. In the Storage Device List window, click the picture of the registered
storage system.

4. Log in to Device Manager - Storage Navigator.
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5. On the Maintenance Utility menu, click Hardware > Other hardware
maintenance to start the maintenance utility.

Note: If a message reports a problem with the website's security,
click Continue to this website (not recommended).
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Replacement parts
The following table lists information about replacement parts for Hitachi
Virtual Storage Platform storage systems. If a replacement part is valid for
certain models only, those models are shown in parentheses.

Part name Part number Model

Status of host and storage
system

I/O from the
host

No I/O from
the host

200-GB, MLC, 12-Gbps, 2.5-
inch flash drive

5559263-A DKC-
F810I-200MEM

YES YES

300-GB, 15kmin-1, 6-Gbps,
SAS, 2.5-inch (contains
BNST)

5552785-A DKC-
F810I-300KCM

YES YES

300-GB, 15kmin-1, 6-Gbps,
SAS, 2.5-inch

5552785-P DKC-
F810I-300KCMC

YES YES

400-GB, MLC, 12-Gbps,, 2.5-
inch flash drive

5559016-A DKC-
F810I-400MEM

YES YES

600-GB, 10kmin-1, 6-Gbps,
SAS, 2.5-inch (contains
BNST)

5552786-A DKC-
F810I-600JCM

YES YES

600-GB, 10kmin-1, 6-Gbps,
SAS, 2.5-inch

5552786-P DKC-
F810I-600JCMC

YES YES

600-GB, 15kmin-1, 12-Gbps,
SAS, 2.5-inch

5559498-A DKC-
F810I-600KGM

YES YES

1.2-TB, 10kmin-1, 6-Gbps,
SAS, 2.5-inch (contains
BNST)

5552789-A DKC-
F810I-1R2JCMC

YES YES

1.2-TB, 10kmin-1, 6-Gbps,
SAS, 2.5-inch

5552789-P DKC-
F810I-1R2JCMC

YES YES

400-GB, MLC, 12-Gbps, 3.5-
inch flash drive

5559090-A DKC-
F810I-400M6M

YES YES

1.2-TB, 10kmin-1, 6-Gbps,
SAS, 3.5-inch (contains
BNST)

5559116-A DKC-
F810I-1R2J5M

YES YES

1.2-TB, 10kmin-1, 6-Gbps,
SAS, 3.5-inch

5559116-P DKC-
F810I-1R2J5MC

YES YES

4-TB, 7200min-1, 6-Gbps,
SAS7.2K, 3.5-inch (contains
BNST)

5552784-A DKC-
F810I-4R0H3M

YES YES

4-TB, 7200min-1, 6-Gbps,
SAS7.2K, 3.5-inch

5552784-P DKC-
F810I-4R0H3MC

YES YES

66 Replacing components
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



Part name Part number Model

Status of host and storage
system

I/O from the
host

No I/O from
the host

6-TB, 7200min-1, 12-Gbps,
SAS7.2K, 3.5-inch

5560075-A DKC-
F810I-6R0H9M

YES YES

Battery (VSP G400, G600 )

CBLM and CBLH 3289081-A DW-F800-BAT YES YES

Fan YES YES

CBSS and CBSL 3290738-A N/A YES YES

Power Supply Unit

CBSS and CBSL 3290737-A N/A YES YES

CBLM and CBLH 3289056-A N/A YES YES

DW-F800-DBS and DW-F800-
DBL (contains BNST)

3290647-A N/A YES YES

DW-F800-DBSC and DW-
F800-DBLC

3290647-P

FMD drive tray 3286659-A N/A YES YES

Controller

CBSS and CBSL 3290733-A DW-F800-CTLS YES YES

CBLM 3289039-A DW-F800-CTLM YES YES

Cache Memory

8 GB 3290718-A DKC-F810I-
CM8G

YES YES

16 GB 5552764-A DKC-F810I-
CM16G

YES YES

Front End Modules

8 Gbps Fibre Channel 3289046-A DW-F800-4HF8 YES YES

16 Gbps Fibre Channel 3289047-A DW-F800-2HF16 YES YES

10 Gbps SFP iSCSI 3289048-A DW-
F800-2HS10S

YES YES

Small Form Factor
Pluggable

Optical module (8 Gbps
LongWave)

5556750-A DKC-F810I-1PL8 YES YES

Optical module (8 Gbps
ShortWave)

5557409-A DKC-
F810I-1PS8

YES YES

Optical module (16 Gbps
LongWave)

5552782-A DKC-
F810I-1PL16

YES YES
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Part name Part number Model

Status of host and storage
system

I/O from the
host

No I/O from
the host

Optical module (16 Gbps
ShortWave)

5552781-A DKC-
F810I-1PS16

YES YES

Disk Board

CBLM and CBLH 3289045-A DW-F800-
BS12G

YES YES

3289094-A DW-F800-
BS12GE

YES YES

ENC

SFF and LFF drive trays 3290646-A N/A YES YES

FMD drive tray 3286658-A N/A YES YES

SAS Cables

1 m SAS cable including two
omega clips

3290630-A DW-F800-SCQ1 YES YES

1.5 m SAS cable including
two omega clips

3290631-A DW-F800-
SCQ1F

YES YES

3 m SAS cable including two
omega clips

3290632-A DW-F800-SCQ3 YES YES

5 m SAS cable including two
omega clips

3290633-A DW-F800-SCQ5 YES YES

10 m SAS optical cable 3290666-A DW-F800-
SCQ10A

YES YES

30 m SAS optical cable 3290667-A DW-F800-
SCQ30A

YES YES

100 m SAS optical cable 3290723-A DW-F800-
SCQ1HA

YES YES

Cache Flash Memory
(CFM)

CFM (VSP G200) 3290736-A DW-F800-BM10 YES YES

CFM 3289043-A DW-F800-BM20 YES YES

CFM 3289043-B DW-F800-BM30 YES YES

LAN Blade

LAN Board (VSP G400, 600,
and 800)

3289044-A N/A YES YES

Backup Module (BKM)

CBSS and CBSL 3290735-A N/A YES YES

CBLM and CBLH 3289036-A N/A YES YES

SVP
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Part name Part number Model

Status of host and storage
system

I/O from the
host

No I/O from
the host

Service Processor 3919435.P N/A YES YES

Removing and replacing the front bezel
To gain access to a storage system, remove the front bezel. After replacing
the component, replace the front bezel.

Removing the front bezel from a DBS or DBL drive tray

Procedure

1. Use the supplied key to unlock the bezel.
2. Holding the lower right part of the bezel, gently pull the key toward you

and disengage the right side of the bezel from the ball catch.

Note: When disengaging the front bezel, do not open the bezel
more than 45 degrees; otherwise, you can damage the bezel.

 

 
3. Disengage the front bezel from the left tabs and then remove the bezel.
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Replacing the front bezel for a CBSS or CBSL controller
To replace the front bezel:

Procedure

1. Use the supplied key to unlock the front bezel. Hold the key and the
bottom of the bezel with both hands, so the front of the bezel is facing
you.

2. Insert the tabs on the left-front side of the storage system into the tab
holes on the front bezel.

3. Push the right side of the bezel until it engages with the ball catch on the
front of the storage system to secure the bezel.
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4. Use the supplied key to lock the front bezel.
 

 

Before turning the key, be sure it is inserted completely into the lock.
Otherwise, you can damage the key.
 

 

When removing the key after locking the front bezel, align its groove
with the positioning mark on the lock. Otherwise, you can damage the
lock.

Removing the front bezel from SFF, LFF, and FMD drive trays

Procedure

1. Use the supplied key to unlock the bezel.
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2. Holding the lower right part of the bezel, gently pull the key toward you
and disengage the right side of the bezel from the ball catch.

Note: When disengaging the front bezel, do not open the bezel
more than 45 degrees; otherwise, you can damage the bezel.

 

 
3. Disengage the front bezel from the left tabs and then remove the bezel.

Replacing the front bezel from a SFF, LFF, or FMD drive tray
To replace the front bezel:

Procedure

1. Use the supplied key to unlock the front bezel. Hold the key and the
bottom of the bezel with both hands, so the front of the bezel is facing
you.

2. Insert the tabs on the left-front side of the storage system into the tab
holes on the front bezel.

3. Push the right side of the bezel until it engages with the ball catch on the
front of the storage system to secure the bezel.
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4. Use the supplied key to lock the front bezel.
 

 

Before turning the key, be sure it is inserted completely into the lock.
Otherwise, you can damage the key.
 

 

When removing the key after locking the front bezel, align its groove
with the positioning mark on the lock. Otherwise, you can damage the
lock.

Remove the front bezel from a CBLM or CBLH controller

Procedure

1. Use the supplied key to unlock the bezel.
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2. Holding the lower right part of the bezel, gently pull the key toward you
and disengage the right side of the bezel from the ball catch.

Note: When disengaging the front bezel, do not open the bezel
more than 45 degrees; otherwise, you can damage the bezel.

 

 
3. Disengage the front bezel from the left tabs and then remove the bezel.

Replacing the front bezel
To replace the front bezel:

Procedure

1. Use the supplied key to unlock the front bezel. Hold the bottom of the
bezel with both hands, so the front of the bezel is facing you.

2. Insert the tabs on the left-front side of the storage system into the tab
holes on the front bezel.

3. Push the right side of the bezel until it engages with the ball catch on the
front of the storage system to secure the bezel.
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4. Use the supplied key to lock the bezel.
Before turning the key, be sure it is inserted completely into the lock.
Otherwise, you can damage the key.
 

 

When removing the key after locking the front bezel, align its groove
with the positioning mark on the lock. Otherwise, you can damage the
lock.

Attaching the front bezel to a dense intermix drive tray

Procedure

1. Use the supplied key to unlock the front bezel.
Hold the key and the bottom of the bezel with both hands, so the front of
the bezel is facing you.

2. Insert the tabs on the left-front side of the storage system into the tab
holes on the front bezel.

3. Push the right side of the bezel until it engages with the ball catch on the
front of the storage system to secure the bezel.

4. Use the supplied key to lock the front bezel.
Before turning the key, verify that it is inserted completely into the lock.
Otherwise, you can damage the key.

5. Remove the key from the lock.
Align the groove of the key with the positioning mark on the lock.
Otherwise, you can damage the lock.
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Removing the front bezel from a dense intermix drive tray
To prevent the rack from tipping when removing a dense intermix drive tray:
• Do not remove multiple dense intermix drive trays at one time.
• After removing the dense intermix drive tray, do not place objects on it or

use it as working space.

To remove the front bezel from the dense intermix drive tray:

Procedure

1. Use the supplied key to unlock the bezel.
2. Holding the lower right part of the bezel, gently pull the key toward you

and disengage the right side of the bezel from the ball catch.

Note: When disengaging the front bezel, do not open the bezel
more than 45 degrees; otherwise, you can damage the bezel.

 

 
3. Disengage the front bezel from the left tabs and then remove the bezel.
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Checking recovery after replacing components
After you replace one or more components, check to verify that the storage
system has recovered.

Procedure

1. In the Maintenance Utility window, click Refresh.
2. Confirm that the status of the replaced components is Normal.
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4
Replacing a drive

Before replacing a drive, read the precautions and understand the procedure
for your drive type.

□ Checking a drive

□ Blocking the drive

□ Replacing a drive for a CBSS or SFF drive tray

□ Replacing a drive for a CBSL or LFF drive tray

□ Replacing a drive for a flash module drive tray

□ Replacing a drive for the dense intermix drive tray

□ Checking the drive status
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Checking a drive

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis or Hardware > Drive Box.
3. Click the Drives tab.
4. Confirm that the status of the drive to be replaced is Warning, Failed,

Blocked, Copy incomplete, or Reserved.
 

 
5. Click Refresh.
6. If the red ALM LED on the failed drive is off:

• In the Drives tab, check which drive is blocked, and then click Block
in the Block Drives window.

• When prompted about whether you want to perform sparing, click
Yes.

• Remove the front bezel and confirm the number of the slot in which
the failed drive is installed.

• Click Close.
• Replace the drive.

7. If the red ALM LED on the failed drive is on:
• Remove the front bezel and confirm the number of the slot in which

the failed drive is installed.
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• Replace the drive.

Blocking the drive

Prerequisites

Check the drive in the maintenance utility.

Procedure

1. Select the drive to be replaced, and then click Block.
2. When the Block Drives window appears, confirm that the drive shown in

the window is the one to be replaced, and then click Block.
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3. If the following warning appears, click Yes.
 

 
4. Confirm that the drive is blocked, and then click Close.

Replacing a drive for a CBSS or SFF drive tray
Facing the front of the chassis, drive numbering in a chassis is #0 to #23,
from left to right.

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• The red ALM LED for the drive to be replaced is on.

Procedure

1. Remove the front bezel.
2. Pull up the stopper of the drive handle toward you to release the lock.
3. Open the handle toward you, and then gently remove the drive to be

replaced.
Handle the drive with care.

4. Place the drive into the guide rail and slide it gently in the direction of
the arrow.

5. Push the lower part of the drive until it reaches the position where the
hook on the handle engages with the square hole on the frame.
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6. Raise the stopper, which is tilted toward you, and then press the stopper
to disengage the lock.
If the handle is raised so the hook of the handle cannot enter into each
hole, the drive cannot be installed properly because it is blocked by the
frame of the storage system.
 

 
7. Gently pull the handle of the drive toward you to make sure the drive is

installed securely.
8. Confirm that the red ALM LED is off at the new drive.
9. In the maintenance utility, click Hardware > Controller Chassis or

Hardware > Drive Box.
10. Click the Drives tab.
11. Confirm that the status of the drive to be replaced is Normal.

If necessary, click Refresh at the top-right of the window to update the
status in the window.

12. Attach the front bezel.

Replacing a drive for a CBSL or LFF drive tray
Facing the front of the chassis, drive numbering in the chassis is #0 to #11,
from the bottom left to the top right.

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
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• The red ALM LED for the drive to be replaced is on.

Procedure

1. Remove the front bezel.
2. Pull up the stopper of the drive handle toward you to release the lock.
3. Open the handle toward you, and then gently remove the drive to be

replaced.
Handle the drive with care.

4. Place the drive into the guide rail and slide it gently in the direction of
the arrow.

5. Push the lower part of the drive until it reaches the position where the
hook on the handle engages with the square hole on the frame.

6. Pull the stopper lightly, close the handle, and then press the stopper to
engage the lock.
If the hook of the handle cannot enter the square hole, the drive cannot
be installed properly because it gets blocked by the frame of the storage
system.
 

 
7. In the maintenance utility, click Hardware > Controller Chassis or

Hardware > Drive Box.
8. Click the Drives tab.
9. Confirm that the status of the drive to be replaced is Normal.

If necessary, click Refresh at the top-right of the window to update the
status in the window.

10. Confirm that the red ALM LED is off at the new drive.
11. Attach the front bezel.
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Replacing a drive for a flash module drive tray
Drive replacement for this drive tray is not supported.

Replacing a drive for the dense intermix drive tray
Facing the front of the chassis, drive numbering is #0 to #59, from the
bottom left to the top right.

When dealing with a dense intermix drive tray:
• Be mindful of other workers nearby.
• Exercise care when removing or storing the dense intermix drive tray.
• Do not pull out multiple dense intermix drive trays at one time because the

rack can fall over.
• Do not put objects on a dense intermix drive tray you removed from the

rack.
• Do not use the dense intermix drive tray as working space because the

rack can fall over.

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• The red ALM LED for the drive to be replaced is on.

Procedure

1. Remove the dense intermix drive tray from the rack and remove the top
cover and bezel.

2. Pull up the stopper of the drive handle toward you to release the lock.
3. Open the handle toward you, and then gently remove the drive to be

replaced.
Handle the drive with care.

4. Place the drive into the guide rail and slide it gently in the direction of
the arrow.
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5. Push the drive until a click indicates it has locked in place.
 

 
6. In the maintenance utility, click Hardware > Controller Chassis or

Hardware > Drive Box.
7. Click the Drives tab.
8. Confirm that the status of the drive to be replaced is Normal.

If necessary, click Refresh at the top-right of the window to update the
status in the window.

9. Confirm that the red ALM LED is off at the new drive.
10. Attach the front bezel, and then replace the dense intermix drive tray in

the rack.

Checking the drive status

Procedure

1. In the maintenance utility, click Hardware > Controller Chassis or
Hardware > Drive Box.

2. Click the Drives tab.
3. Confirm that the status of the replacement drive is Normal.

Observe the following guidelines:
• If you replaced a drive without blocking it, click Refresh at the top-

right of the Maintenance Utility window to update the window, and
then check the status of the replaced drive.
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• When replacing a drive after saving data to a spare drive, the drive
status changes to Normal after performing the copy-back operation.
This operation can take up to 12 hours to perform, depending on the
configuration and drive capacity

• If the drive status is Copy incomplete, the correction-copy operation
cannot be performed because a copy-processing operation is being
performed in the parity group to which the target drive belongs.
Complete the other copy-processing operation, and then replace the
drive.

• If the drive status is Reserved, the copy-back operation cannot be
performed because more than one copy-processing operation is being
performed in the parity group to which the copy-back source drive of
the target drive belongs. Complete the other copy-processing
operation, and then replace the drive.

• If the copy-back operation is set to disabled, this operation will not be
performed.

Replacing a drive 87
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



88 Replacing a drive
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



5
Replacing a battery

Hitachi Virtual Storage Platform G400, G600 systems have replaceable
batteries. Before replacing a battery on these storage systems, read the
precautions and understand the procedure for your battery.

□ Checking the battery

□ Replacing the battery
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Checking the battery

Prerequisites

• Storage system power is turned on.
• The red STATUS LED for the backup module containing the battery to be

replaced is blinking.

• The power supply is operating normally.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. In the Controller Chassis window, click the BKMFs tab.
4. Confirm that the status of the battery to be replaced is Warning.

 

 

Replacing the battery
The blink pattern of the red STATUS LED indicates which battery needs
replacement.
• One blink:: Replace the standard battery.
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• Two blinks:: Replace the optional battery.
• Three blinks:: Replace both the standard and optional batteries.

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• The red STATUS LED for the backup module containing the battery to be

replaced is blinking.
• Use the maintenance utility to check the battery.

Procedure

1. Loosen the blue screw that secures the BKMF whose red STATUS LED is
blinking.

2. Open the lever to pull out and remove the BKMF with both hands.
3. Find the BKMF whose red STATUS LED is blinking, and then loosen the

blue screw that secures that BKMF.
4. Slide the top panel of the BKMF and remove it.
5. Hold the latch of the cable connector of the battery to be replaced and

remove the connector from the socket.
6. Remove the battery to be replaced.
7. Install a new battery in the BKMF and route cables along the groove of

the BKMF.
If replacing one battery, install the replacement battery at the front (fan)
side of the system. The battery clicks into place when installed securely
in the slot. Route cables with minimum bending.

8. Connect the cable connector to the socket. You will hear a click when the
connection is secure.

9. Replace the BKMF top panel by sliding it and then attaching it.
10. Tighten the blue screw on the rear side of the BKMF.
11. With the lever of the BKMF opened, hold the BKMF with both hands and

insert it straight into the slot.
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12. Close the lever of the BKMF, and tighten the blue screw.
 

 
13. Check that the green STATUS LED on the BKMF is blinking.
14. In the Maintenance Utility window, click Hardware > Controller

Chassis.
15. Click the BKMF tab.
16. Confirm that the status of the replacement battery is Normal.
17. Log out and close the Maintenance Utility window.
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6
Replacing a fan

Before replacing a fan, read the precautions and understand the procedure
for your fan.

□ Blocking the controller

□ Replacing a fan

□ Restoring a fan
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Blocking the controller

Procedure

1. Use the amber CTL WARN LED to identify the failed fan that needs to be
replaced:
• If the LED blinks 1 time, replace fan 0.
• If the LED blinks 2 times, replace fan 1.

2. Start the maintenance utility.
3. Click Hardware > Controller Chassis.
4. In the Controller Chassis window, click the CTLs tab.
5. Confirm that the status of the controller to be replaced is Warning.

 

 
6. Click the Replace list, and select the controller that contains the cache

memory you want to replace.
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7. When the Replace FANs window appears, verify that the fan shown in
the window is the one to be replaced, and then click Block.
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8. Check that the controller is blocked and becomes ready for replacing.
Leave the Replace FANs window open, but do not click the Restore
button.
 

 

Replacing a fan

Caution: Storage system fans rotate at high speed. Exercise extreme caution
to avoid getting anything caught in the fan and to prevent injury.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• A fan is installed in the controller.
• Storage system power is turned on.
• The amber CTL WARN LED is blinking one or two times rapidly (one blink =

replace fan 0, two blinks = replace fan 1).
• Use the maintenance utility to block the controller.
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Note: Storage system fans rotate at high speed. Exercise extreme caution to
avoid getting anything caught in the fan and to prevent injury.

Procedure

1. Remove all optical and SAS cables connected to the controller.
2. Loosen the blue screw that secures the controller, and then open the

lever.
3. Hold the controller with both hands, and then pull it gently and remove

it.
4. Loosen the blue screw that secures the fan.
5. Lift the fan and remove it from the connector.
6. Install the new fan into the connector of the controller.

 

 
7. Tighten the blue screw to secure the fan.
8. Check that the controller connector is in good condition (not deformed or

damaged).
9. With the right and left controller levers open completely, insert the

controller into the slot of the Controller.
10. Push the controller in all the way, and then close the right and left levers

completely.
11. Tighten the blue screw to secure the controller.
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12. Connect all the optical and SAS cables that you removed from the
controller.

Postrequisites
• Use the maintenance utility to restore (unblock) the controller.

Restoring a fan

Procedure

1. In the Replace FANs window, click Restore.
A progress bar shows the replacement status.

Note: The restore operation can take up to 20 minutes to
complete. If a message states that the recovery failed, go to the
HDS Support Portal at https://portal.hds.com.

 

 
2. When the progress bar goes away and the completion message appears,

click Close.
3. Confirm that the amber CTL WARN LED is off at the fan.
4. In the BKMFs tab, click Refresh at the top-right of the window and

confirm that the fan status is Normal.

98 Replacing a fan
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide

https://portal.hds.com


5. Log out and close the Maintenance Utility window.
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7
Replacing a power supply

Before replacing a power supply, read the precautions and understand the
procedure for your power supply.

The following topics are covered in this chapter:

□ Checking the power supply

□ Replacing a power supply for a CBSS or CBSL

□ Replacing a power supply for a CBLM or CBLH

□ Replacing a power supply for SFF and LFF drive trays

□ Replacing a power supply for a FMD drive tray

□ Confirming the power supply unit status
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Checking the power supply

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis or Hardware > Drive Box.
3. In the Controller Chassis window, click the PSs tab.
4. Confirm that the status of the power supply to be replaced is Warning.

 

 

Replacing a power supply for a CBSS or CBSL

Caution: Be sure to replace the faulty power supply. If you replace the
operational power supply, the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Note: Power supply unit #1 and power supply unit #2 are installed in
opposite directions.
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Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• The red ALM/RDY LED for the power supply to be replaced is on.

Note: If the red ALM/RDY LED is on at both power supplies, do not perform
this procedure. Contact the HDS Support Portal at https://portal.hds.com.

Procedure

1. Disconnect the power cable from the power supply to be replaced.
Remove the cable holder to disconnect the power cable from the power
supply.

2. Hold up the latch on the cable holder of the power supply to release the
lock, and then slide the cable holder forward.

3. Pull the lever open while pressing the latch on the power supply inward
with right thumb.
When the lever is completely opened, the power supply moves forward.
 

 
4. Pull out and remove it while holding the body of the power supply with

both hands.
5. Insert the new power supply into the slot.
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6. Wait at least 20 seconds, and then push the power supply until the latch
clicks. If the latch does not click, reorient the power supply, and then
reinsert it into the slot.

7. Connect the power cable to the power supply, and then secure the cable
with the cable holder.

8. Confirm that the red ALM/RDY LED is off at the power supply and the
green ALM/RDY LED is on.
If the red ALM/RDY LED does not go off after more than 30 minutes
following replacement of the power supply, remove the power supply,
wait at least 30 seconds, and then reinstall it.

Replacing a power supply for a CBLM or CBLH

Caution: Be sure to replace the faulty power supply. If you replace the
operational power supply, the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Note: Power supply unit #1 and power supply unit #2 are installed in
opposite directions.

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• The red ALM LED for the power supply unit to be replaced is on.

Note: If the red ALM LED is on at both power supplies, do not perform this
procedure. Contact the HDS Support Portal at https://portal.hds.com.

Procedure

1. Disconnect the power cable from the power supply to be replaced.
Remove the cable holder to disconnect the power cable from the power
supply.

2. Using a Phillips screwdriver, loosen the blue screw that secures the power
supply.

3. Open the lever to remove the power supply.
When the lever is completely opened, the power supply moves forward.
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4. Hold the power supply with both hands, and then pull it gently and
remove it.
 

 
5. Hold up the latch on the cable holder of the new power supply to release

the lock, and then slide the cable holder forward.
6. With the lever opened completely, insert the new power supply into the

slot. Wait at least 20 seconds, and then insert the power supply all the
way into the slot. If the power supply does not install all the way into the
slot, reorient the power supply, and then reinsert it into the slot.

7. Close the lever completely.
8. Using a Phillips screwdriver, tighten the blue screw to secure the power

supply.
9. Connect the power cable to the power supply, and then secure the cable

using the cable holder.
10. Confirm that the red ALM LED is off at the power supply and the green

RDY LED is on.
If the red ALM LED does not go off after more than 30 minutes following
replacement of the power supply, remove the power supply, wait at least
30 seconds, and then reinstall it.

Replacing a power supply for SFF and LFF drive trays

Caution: Be sure to replace the faulty power supply. If you replace the
operational power supply, the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Note: Power supply unit #1 and power supply unit #2 are installed in
opposite directions.
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Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• The red ALM LED for the power supply unit to be replaced is on.

Note: If the red ALM LED is on at both power supplies, do not perform this
procedure. Contact the HDS Support Portal at https://portal.hds.com.

Procedure

1. Disconnect the power cable from the power supply to be replaced.
Remove the cable holder to disconnect the power cable from the power
supply.

2. Pull the lever open while pressing the latch on the power supply inward
with your right thumb. When the lever is completely opened, the power
supply moves forward.
 

 
3. Hold the power supply with both hands, and then pull it gently and

remove it.
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4. With the lever opened completely, insert the new power supply into the
slot.
Wait at least 20 seconds, and then insert the power supply all the way
into the slot.

5. Close the lever completely and secure the power supply. If the lever
cannot be moved, reorient the power supply, and then reinsert it into the
slot.

6. Connect the power cable to the power supply, and then secure the cable
using the cable holder.

7. Confirm that the red ALM LED is off at the power supply and the green
RDY LED is on.
If the red ALM LED does not go off after more than 30 minutes following
replacement of the power supply, remove the power supply, wait at least
30 seconds, and then reinstall it.

Replacing a power supply for a FMD drive tray

Caution: Be sure to replace the faulty power supply. If you replace the
operational power supply, the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Note: Power supply unit #1 and power supply unit #2 are installed in
opposite directions.

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• The red ALM LED for the power supply unit to be replaced is on.

Note: If the red ALM LED is on at both power supplies, do not perform this
procedure. Contact the HDS Support Portal at https://portal.hds.com.

Procedure

1. Disconnect the power cable from the power supply to be replaced.
Remove the cable holder to disconnect the power cable from the power
supply.
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2. Pull the lever open while pressing the latch on the power supply inward
with your right thumb. When the lever is completely opened, the power
supply moves forward.
 

 
3. Hold the power supply with both hands, and then pull it gently and

remove it.
4. With the lever opened completely, insert the new power supply into the

slot. Wait at least 20 seconds, and then insert the power supply all the
way into the slot.

5. Close the lever completely and secure the power supply. If the lever
cannot be moved, reorient the power supply, and then reinsert it into the
slot.

6. Connect the power cable to the power supply, and then secure the cable
using the cable holder.

7. Confirm that the red ALM LED is off at the power supply and the green
RDY LED is on.
If the red ALM LED does not go off after more than 30 minutes following
replacement of the power supply, remove the power supply, wait at least
30 seconds, and then reinstall it.

Confirming the power supply unit status

Procedure

1. Click Hardware > Controller Chassis or Hardware > Drive Box.
2. In the Controller Chassis window, click the PSs tab.
3. In the PSs tab in the Maintenance Utility window, confirm that the

status of the power supply unit changed to Normal.

108 Replacing a power supply
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



If necessary, click Refresh at the top-right of the window to update the
status in the window.

4. Log out and close the Maintenance Utility window.
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8
Replacing a controller

Before replacing a controller, read the precautions and understand the
procedure for your controller.

The following topics are covered in this chapter:

□ Blocking the controller

□ Replacing a controller for a CBSS or CBSL controller

□ Replacing a CBLM or CBLH controller

□ Restoring a controller
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Blocking the controller

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. In the Controller Chassis window, click the CTLs tab.
4. Confirm that the status of the controller to be replaced is Warning.

 

 
5. Click the Replace list, and select the controller that contains the cache

memory you want to replace.
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6. When the Replace Controller Board window appears, verify that the
controller shown in the window is the one to be replaced, and then click
Block.
 

 
7. If prompted that the target controller is in the normal status, click OK to

proceed.
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8. Check that the controller is blocked and becomes ready for replacing.
Leave the Replace Controller Board window open, but do not click the
Restore button.
 

 

Replacing a controller for a CBSS or CBSL controller
When you replace a CBSS or CBSL controller, you will have to install the
following components on the new controller:
• Fan
• Cache memory
• Front end module
• Cache flash memory
• Backup module

Removing the controller

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• Storage system power is turned on.
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• The red CTL ALARM LED for the controller to be replaced is on.

Procedure

1. Remove all cables connected to the controller.
2. Loosen the blue screw that secures the controller, and then open the

lever.
 

 
3. Hold the controller with both hands, and then pull it gently in a straight

direction and remove it.
Keep the controller straight to avoid jostling the components above and
below it.

4. Install the fan, cache memory, front end module, and CFM on the new
controller.

Postrequisites
• Install the controller.
• Use the maintenance utility to restore (unblock) the controller.

Replacing a controller 115
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



Removing and installing the fan

Caution: Storage system fans rotate at high speed. Exercise extreme caution
to avoid getting anything caught in the fan and to prevent injury.

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• The controller must be removed from the storage system.

Procedure

1. Loosen the blue screw that secures the fan.
2. Lift the fan and remove it from the connector.
3. Install the fan into the connector of the new controller.
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4. Tighten the blue screw to secure the fan.
 

 

Removing and installing cache memory

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.
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Procedure

1. Press the button, and then slide the dual in-line memory module (DIMM)
cover in the direction of the arrow and remove the DIMM cover from the
hooks on either side.

2. Lift the DIMM cover gently to remove it.

Note: The DIMM cover has a band that can be damaged easily.
Exercise care when removing the DIMM cover.

 

 
3. Pull the lever outward.
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4. Hold both ends of the cache memory, and then gently pull out the cache
memory from the socket.

Note: Do not exert pressure on the cache memory. Otherwise, you
can damage the printed-circuit board.

 

 
5. Align the notch on the cache memory board with the projection inside

the slot.
6. Holding both ends of the cache memory, insert it into the socket.
7. Confirm that the lever is securing the cache memory.
8. To install the DIMM cover, slide it in the direction of the arrow. Confirm

that the DIMM cover is secured by the two hooks on either side.

Postrequisites
• Install the controller.
• Use the maintenance utility to restore (unblock) the controller.

Removing and installing a front end module

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• Remove the controller.

Procedure

1. Disconnect the optical cable from the front end module to be replaced.
2. Loosen the two blue screws that secure the front end module.
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3. Using the blue screw, pull out the front end module in a straight direction
and remove.

4. Connect the optical cable to the new front end module.
5. Insert the front end module into the slot of the new controller.
6. Push the front end module all the way into the slot.
7. Tighten the two blue screws to secure the front end module.

Removing and installing cache flash memory

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• The controller must be removed from the storage system.

Procedure

1. Loosen the blue screw that secures the cache flash memory (CFM).
2. Open the lever.
3. Using both hands, hold the body of the CFM and remove it.

 

 
4. With the lever opened completely, insert the CFM into the slot.
5. Push the CFM all the way into the slot.
6. Close the lever completely.
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7. Tighten the blue screw to secure the CFM.

Postrequisites
• Once all parts are installed on the controller, install it in the storage

system.
• Use the maintenance utility to restore (unblock) the controller.

Removing and installing the backup module

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• The controller must be removed from the storage system.

Procedure

1. Loosen the blue screw that secures the backup module.
2. Open the lever, and then use both hands to remove the backup module.
3. With the backup module lever opened, insert the backup module into the

slot of the new controller.
4. Close the backup module lever and tighten the blue screw.

Installing a controller

Prerequisites

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Complete the installation of all components from the old controller.

Procedure

1. With the right and left levers of the new controller open completely,
insert it into the slot of CBSS or CBSL.
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2. Push the controller all the way into the slot until the right and left levers
close completely.
 

 
3. Tighten the blue screw to secure the controller.
4. Confirm that the red CTL ALM LED on the controller is off.
5. Connect all the cables you removed.

Replacing a CBLM or CBLH controller
When you replace a CBLM or CBLH controller, you will have to install the
following components on the new controller:
• Cache memory
• Cache flash memory
• Backup module

You must remove the backup module first, and then remove the controller.

Removing a CBLM or CBLH controller

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• Use the maintenance utility to block the controller.
• The red CTL ALARM LED for the controller to be replaced is on.

122 Replacing a controller
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



Procedure

1. Loosen the right and left blue screws on the lever of the controller in the
front of the CBLM or CBLH controller, and then open the lever.

2. Loosen the blue screw securing the Backup Module (BKMF).
3. Pull out and remove the BKMF.

 

 
4. Remove all four BKMF modules installed in the controller.
5. Loosen the blue right and left screws on the lever of the controller, and

then open the lever.
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6. With the lever opened completely, hold the controller with both hands,
and then pull it gently and remove it.
Keep the controller straight to avoid jostling the components above and
below it.
 

 

Postrequisites
• Install the backup module (BKMF) in the new controller.
• Install the cache memory on the new controller.
• Install the cache flash memory on the new controller.
• Use the maintenance utility to restore (unblock) the controller.

Note: If the POWER/READY/WARNING/ALARM LED on the front of the CBLM/
CBLH goes off after removing the controller, check the status of the storage
system in the Maintenance Utility window, and then continue the
replacement work. After restoring the controller (described later), confirm
that the LED goes on.
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Removing and installing cache memory

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• The controller is removed from the storage system.

Procedure

1. Open the air guide.
 

 
2. Pull the lever outward.
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3. Holding both ends of the cache memory, pull out the cache memory from
the socket.

Note: Do not exert pressure on the cache memory. Otherwise, you
can damage the printed-circuit board.

 

 
 

 

Note: DIMMs are installed in sets of four. There are two groups of
cache memory DIMM slots: CMG0 and CMG1. Populate the CMGO slots
first, and then populate the CMG1 slots if necessary.

4. Align the notch on the cache memory board with the projection inside
the slot.

5. Holding both ends of the cache memory, insert it into the socket of the
new controller.

6. Check that the lever is securing the cache memory.
7. Close the air guide.
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Postrequisites
• Once all components are installed on the controller, install the controller in

the storage system.
• Use the maintenance utility to restore (unblock) the controller.

Removing and installing cache flash memory for a CBLM or CBLH
controller

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• The controller must be removed from the storage system.

Procedure

1. Loosen the blue screw that secures the cache flash memory (CFM).
2. Open the lever.
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3. Using both hands, hold the body of the CFM and remove it.
 

 
4. With the lever opened completely, insert the CFM into the slot.
5. Push the CFM all the way into the slot.
6. Tighten the blue screw to secure the CFM.

Postrequisites
• Once all parts are installed on the controller, install it in the storage

system.
• Use the maintenance utility to restore (unblock) the controller.
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Installing a controller in a CBLM or CBLH controller

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

Procedure

1. With the right and left levers on the new controller opened completely,
insert the controller into the slot of the CBLM or CBLH chassis.
Hold the controller with both hands and move it in a straight direction.
 

 
2. With the lever closed on the BKMF you removed, tighten the blue screw

to secure the BKMF.
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3. Install the four BKMFs on the controller.
 

 
4. Push the controller in all the way.

The right and left covers close completely.
5. Tighten the blue screw to secure the controller.
6. Confirm that the red CTL ALM LED on the new controller is off.
7. Attach the front bezel.

Postrequisites
• Use the maintenance utility to restore (unblock) the controller.

Restoring a controller

Procedure

1. At the Replace Controller Board window, click Restore. A progress bar
shows the replacement status.
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Note: The restore operation can take up to 20 minutes to
complete. If a message states that the recovery failed, go to the
HDS Support Portal at https://portal.hds.com.

2. When the progress bar goes away and the completion message appears,
click Close.

3. Click CTLs tab and confirm that the status of the new controller you
replaced is Normal. If necessary, click Refresh at the top-right of the
window to update the status in the window.

4. Log out and close the Maintenance Utility window.

Replacing a controller 131
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide

https://portal.hds.com


132 Replacing a controller
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



9
Replacing cache memory

Before replacing cache memory, read the precautions and understand the
procedure for your cache memory.

The following topics are covered in this chapter:

□ Checking cache memory

□ Replacing cache memory for a CBLM or CBLH controller

□ Replacing cache memory for a CBSS or CBSL controller

□ Replacing cache memory for a CBLM or CBLH controller

□ Restoring cache memory

Replacing cache memory 133
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



Checking cache memory

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
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3. Click the CTLs tab.
 

 
 

 
4. Confirm that the status of the cache memory to be replaced is Warning.
5. Click Close.
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Replacing cache memory for a CBLM or CBLH controller

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. In the Controller Chassis window, click the CTLs tab.
4. Confirm that the component you want to replace has the status Warning

or Failed.
5. Click the Replace list, and select the controller that contains the cache

memory you want to replace.
6. Click Block.

 

 

136 Replacing cache memory
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



7. Check that the controller is blocked and becomes ready for replacing.
Leave the Replace Cache Memories window open, but do not click the
Restore button.
 

 

Replacing cache memory for a CBSS or CBSL controller

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• Storage system power is turned on.
• The red CTL ALARM LED for the controller containing the cache memory to

be replaced is on.

Procedure

1. Remove all cables connected to the controller.
2. Loosen the blue screw that secures the controller and open the lever.
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3. Hold the controller with both hands, and then gently remove it. Keep the
controller straight to avoid touching the components above and below it.
 

 
4. Press the button near the dual in-line memory module (DIMM) cover,

slide the cover in the direction of the arrow.
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5. Lift and remove the DIMM cover from the hooks on either side.

Note: The DIMM cover has a band that can be damaged easily.
Exercise care when removing the DIMM cover.

 

 
6. Note the cache memory locations.

 

 
7. Pull the lever outward.
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8. Hold both ends of the cache memory by the fingers, and then gently
remove the cache memory from the socket.

Note: Do not exert pressure on the cache memory. Otherwise, you
can damage the printed-circuit board.

 

 
9. Alight the notch on the cache memory board with the projection inside

the slot.
10. Holding both ends of the cache memory, insert it into the socket of the

new controller.
11. Check that the lever is securing the cache memory.
12. To install the DIMM cover, slide it in the direction of the arrow. Confirm

that the DIMM cover is secured by the two hooks on either side.
13. Check that the connector of the controller is not damaged, deformed, or

dusty.
14. With the right and left levers on the controller opened completely, insert

it into the slot of CBSS or CBSL controller.
15. Push the controller in all the way. The right and left levers close

completely.
16. Tighten the blue screw to secure the controller.
17. Connect all cables removed from the controller.
18. Confirm that the red CTL ALM LED on the controller in which the cache

memory was installed goes off.

Postrequisites
• Use the maintenance utility to restore (unblock) the controller.
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Replacing cache memory for a CBLM or CBLH controller
When replacing cache memory on a CBLM or CBLH controller, remove the
backup module first, and then remove the controller. A single CBLM or CBLH
controller weighs approximately 42 pounds (19 kg).

 

 

Note: DIMMs are installed in sets of four. There are two groups of cache
memory DIMM slots: CMG0 and CMG1. Populate the CMGO slots first, and then
populate the CMG1 slots if necessary.

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• Storage system power is turned on.
• The red CTL ALARM LED for the controller containing the cache memory to

be replaced is on.

Procedure

1. Remove the front bezel.
2. Loosen the blue left and right screws on the lever of the controller to add

the cache memory in the front of the CBLM or CBLH and open the lever.
3. Loosen the blue screw securing the backup module.

Replacing cache memory 141
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



4. With the lever opened, pull out and remove the backup module.
 

 
5. Remove all four backup modules installed in the controller.
6. Loosen the blue right and left screws on the lever of the controller, and

then open the lever.
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7. Hold the controller with both hands and gently remove it. Keep the
controller straight to avoid touching the components above and below it.
 

 
8. Open the air guide.
9. Pull the lever outward.
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10. Hold both ends of the cache memory, and then gently pull out the cache
memory from the socket.

Note: Do not exert pressure on the cache memory. Otherwise, you
can damage the printed-circuit board.

 

 
11. Align the notch on the cache memory board with the projection inside

the slot.
12. Holding both ends of the cache memory, insert it into the socket.
13. Confirm that the lever is securing the cache memory.
14. Close the air guide.
15. Confirm that the connector of the controller is not damaged, deformed,

or dusty.
16. With the right and left levers of the controller opened completely, insert

it into the slot of the controller.
17. Push the controller in all the way.

The right and left levers close completely.
18. Tighten the blue screw to secure the controller.
19. With the lever on the backup module open, insert the backup module

into the slot.
20. With the backup module lever closed, tighten the blue screw to secure it.
21. Install the four backup modules on the controller.
22. Push the controller all the way into the slot until the right and left levers

close completely.
23. Tighten the blue screw to secure the controller.
24. Confirm that the red CTL ALM LED on the controller in which the cache

memory was installed goes off.

Postrequisites
• Use the maintenance utility to restore (unblock) the controller.
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Restoring cache memory

Procedure

1. At the Replace Cache Memories window, click Restore.
A progress bar shows the replacement status.

Note: The restore operation can take up to 20 minutes to
complete. If a message states that the recovery failed, go to the
HDS Support Portal at https://portal.hds.com.

2. When the progress bar goes away and the completion message appears,
click Close.

3. Click CTLs tab and confirm that all status conditions are Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

4. Log out and close the Maintenance Utility window.
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Replacing a front end module

Before replacing a front end module, read the precautions and understand
the procedure for your front end module.

Controller 1 and Controller 2 must have the same number of front end
modules installed. For example, if you install a second front end module to
Controller 1, you must also install a new front end module to Controller 2.
You cannot add a front end module to one controller without adding a front
end module to the other controller.

□ Blocking a front end module

□ Adding a front end module

□ Restoring a front end module
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Blocking a front end module

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. Click the CHBs tab.
4. Confirm that the status of the front end module to be replaced is

Warning.
 

 
5. Click the front end module to be replaced, and then click Replace.
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6. Click Block.
 

 
7. Verify that the front end module is blocked and is ready for replacing.
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8. Leave the Replace Channel Board window open, but do not click
Restore.
 

 

Adding a front end module

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the front end module.
• Storage system power is turned on.

Procedure

1. Disconnect the optical fiber cable from the front end module.
2. Loosen the two blue screws that secure the front end module.

150 Replacing a front end module
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



3. Gently remove the front end module.
When removing the front end module, hold the blue screw and keep the
front end module straight avoid jostling the components above and
below it.
 

 
 

 
4. Orient the new front end module upside-down.
5. Connect the optical fiber cable to the new front end module.
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6. Insert the new front end module into the slot, just before the "shield
finger."
 

 
7. Gently push the front end module all the way into the slot.
8. Tighten the two blue screws to secure the front end module.
9. Confirm that the red STATUS LED on the front end module goes off.

Postrequisites
• Use the maintenance utility to restore (unblock) the front end module.

Restoring a front end module

Procedure

1. At the Replace Channel Board window, click Restore.
A progress bar shows the replacement status.

Note: It can take up to 20 minutes for the controller to recover. If
a message states that the recovery failed, go to the HDS Support
Portal at https://portal.hds.com.

2. When the progress bar goes away and the completion message appears,
click Close.

3. Click the CHBs tab in the Controller Chassis window.
4. Confirm that the status of the new front end module is Normal.

If necessary, click Refresh at the top-right of the window to update the
status in the window.

5. Log out and close the Maintenance Utility window.
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Replacing a small form-factor pluggable

(SFP)
Before replacing a small form-factor pluggable (SFP) port, read the
precautions and understand the procedure for your SFP.

Note: SFP ports also have been referred to as a mini-GigaBit or (GBIC)
ports. However, this term has been made obsolete by SFP.

□ Checking an SFP

□ Replacing an SFP
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Checking an SFP

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. In the Controller Chassis window, click the CHBs tab.
4. Confirm that the status of the SFP to be replaced is Warning.

 

 
5. In the SFP Status column, click the warning to display a pop-up window

with SFP port ID, status, and type information.
6. Replace the SFP. Do not click Close at this time.

Replacing an SFP
Install the same type of SFP as the one being replaced. The color of the lever
or the entire SFP identifies the SFP type:
• Shortwave SFPs are black.
• Longwave SFPs are blue.
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Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.

Procedure

1. Disconnect the optical cable from the SFP to be replaced.
2. Pull the SFP lever down toward you and pull out the SFP.

If you cannot remove the SFP, pull it out while pushing open the lever
toward you.
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3.  

 
Wait at least 10 seconds, and then check the SFP insertion direction and
insert the SFP into the port until it clicks.

Note: Replace the SFP with the same type being removed.

4. Connect the optical cable to the new SFP. Check that optical cable latch
clicks and the cables are surely connected.

5. Confirm that the red STATUS LED on the front end module is off.
6. In the Controller Chassis window, confirm that the status of the

replacement SFP is Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.
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7. Log out and close the Maintenance Utility window.
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Replacing an ENC

Before replacing an ENC, read the precautions and understand the procedure
for your ENC.

□ Blocking an ENC

□ Replacing the ENC for SFF and LFF drive trays

□ Replacing the ENC for a FMD drive tray

□ Restoring an ENC
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Blocking an ENC

Procedure

1. Start the maintenance utility.
2. Click Hardware > Drive Box.
3. In the Drive Box window, click the ENCs tab.
4. Confirm that the status of the ENC to be replaced is Warning.
5. Click the ENC to be replaced, and then click Replace.
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6. When the Replace ENC window appears, confirm that the ENC shown in
the window is the one to be replaced.
 

 
7. Click Block.
8. Verify that the ENC is blocked and is ready for replacing.
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9. Leave the Replace ENC window open, but do not click the Restore
button.
 

 

Replacing the ENC for SFF and LFF drive trays
Do not touch the ENC connector because it is fragile. Check that the ENC
connector is in good shape and is not deformed, damaged, or dusty before
installing the ENC.

Note: Be sure to replace the faulty ENC. If you replace the operational ENC,
the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• Use the maintenance utility to block the ENC.
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• The red ALARM LED for the ENC to be replaced is on.

Procedure

1. Disconnect the SAS cable from the ENC to be replaced.
2. Open toward you the right and left levers that secure the ENC.

When the levers are completely opened, the ENC moves forward.
3. Hold the ENC with both hands, and then pull it gently and remove it.
4. Open completely the right and left levers of the new ENC.
5. Insert the ENC into the slot, and then push the right and left levers

toward the ENC until the levers open slightly.
 

 
6. Confirm that the red ALARM LED on the new ENC is off.
7. Connect the SAS cable to the new ENC.

Postrequisites
• Use the maintenance utility to restore (unblock) the ENC.

Replacing the ENC for a FMD drive tray
Do not touch the ENC connector because it is fragile. Check that the ENC
connector is in good shape and is not deformed, damaged, or dusty before
installing the ENC.

Note: Be sure to replace the faulty ENC. If you replace the operational ENC,
the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.
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Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• Use the maintenance utility to block the ENC.
• The red ALARM LED for the ENC to be replaced is on.

Procedure

1. Disconnect the SAS cable from the ENC to be replaced.
2. Open toward you the right and left levers that secure the ENC.

When the levers are completely opened, the ENC moves forward.
3. Hold the ENC with both hands, and then pull it gently and remove it.
4. Open completely the right and left levers of the new ENC.
5. Insert the ENC into the slot, and then push the right and left levers

toward the ENC until the levers open slightly.
6. Confirm that the red ALARM LED on the new ENC is off.
7. Connect the SAS cable to the new ENC.

Restoring an ENC

Procedure

1. At the Replace ENC window, click Restore.
A progress bar shows the replacement status.

2. When the progress bar goes away and the completion message appears,
click Close.

3. Click the ENCs tab in the Drive Box window and confirm that the status
of the new ENC is Normal.
If necessary, click Refresh at the top-right of the window to update the
status of the window.

4. Log out and close the Maintenance Utility window.
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Replacing a SAS cable

Before replacing a SAS cable, read the precautions and understand the
procedure for your SAS cable.

SAS cables come in the following shapes:

Model Name Shape

DW-F800-SCQ1

DW-F800-SCQ1F

DW-F800-SCQ3

DW-F800-SCQ5

 

 

DW-F800-SCQ10A

DW-F800-SCQ30A

DW-F800-SCQ1H

 

 

• Block the connected chassis and replace the SAS cables.
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• For SAS cable DW-F800-SCQ1HA, replace the SAS adapter first. If
recovery fails even after replacing the SAS adapter, replace the cable.

• The cable thickness and connector shape depend on the model name of
the SAS cable.

□ Replacing SAS cables connected to a CBSS or CBSL controller

□ Replacing SAS cables connected to a CBLM or CBLH controller

□ Replacing SAS cables on a drive tray
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Replacing SAS cables connected to a CBSS or CBSL
controller

Replacing SAS cables for a CBSS or CBSL controller requires you to block a
controller before replacing the cables.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, Hardware --> Controller

Chassis.
3. Click the CTLs tab. Check the status of the controller, and then click the

Replace list and select the controller whose SAS cable you want to
replace.

4. After checking that the appropriate controller has been selected, click
Block.

5. When the Replace Controller Board window appears, verify that the
controller shown in the window is the one whose SAS cables are to be
replaced, and then click Block.
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6. Check that the controller is blocked and becomes ready for replacing the
SAS cables. Leave the Replace Controller Board window open, but do
not click the Restore button.
 

 
7. Confirm that the red CTL ALM LED on the controller is on.
8. Release the routing of the SAS cable connected to the CBSS or CBSL.
9. Remove the SAS cable from the back end module on the CBSS or CBSL.

10. Remove the SAS cable from the ENC on the drive tray connected to the
CBSS or CBSL.
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11. For SAS cable DW-F800-SCQ1HA:
a. Remove the cable from the SAS adapters you want to replace.
b. Pull the latch of the cables and remove them from the SAS adapters.
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12. Connect new SAS cables to the back end module on the CBSS or CBSL
and to the ENC of the drive tray connected to the CBSS or CBSL.

Note: When connecting the SAS cable DW-F800-SCQ1HA to a SAS
adapter, be sure the cable latch clicks and that the cables are
connected securely to the SAS adapter.

 

 
13. Confirm that the red STATUS LED for the back end module is off.
14. Route the cables appropriately.

Note: When connecting the DW-F800-SCQ1HA SAS adapter, you
do not have to route the SAS cable.

15. At the Replace Controller Board window, click Restore.
A progress bar shows the replacement status.

Note: The restore operation can take up to 20 minutes to
complete. If a message states that the recovery failed, go to the
HDS Support Portal at https://portal.hds.com.

16. When the progress bar goes away and the completion message appears,
click Close.

17. Click the CTLs tab, and then check that the controller whose SAS cable
you replaced is Normal.

18. Log out and close the Maintenance Utility window.
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Replacing SAS cables connected to a CBLM or CBLH
controller

Replacing SAS cables for a CBLM or CBLH controller requires you to block a
back end module before replacing the cables.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware --> Controller

Chassis.
3. Click the DKBs tab. Check the status of the back end module, and then

click the Replace list and select the back end module whose SAS cable
you want to replace.

4. After checking that the appropriate back end module has been selected,
click Block.

5. When the Replace Disk Board window appears, verify that the back
end module shown in the window is the one whose SAS cables are to be
replaced, and then click Block.
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6. Leave the Replace Disk Board window open, but do not click the
Restore button.
 

 
7. Confirm that the red STATUS LED on the back end module whose SAS

cable you want to replace is on.
8. Unroute the SAS cable connected to the CBLM or CBLH.

Note: When replacing the SAS adapter for DW-F800-SCQ1HA, you
do not have to release the routing of the SAS cable.

9. Remove the SAS cable from the back end module on the CBLM or CBLH.
10. Remove the SAS cable from the ENC on the drive tray connected to the

CBLM or CBLH.
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11. For SAS cable DW-F800-SCQ1HA:
a. Remove the cable from the SAS adapters you want to replace.
b. Pull the latch of the cables and remove them from the SAS adapters.
 

 
12. Connect new SAS cables to the back end module on the CBLM/CBLH and

to the ENC of the drive tray connected to the CBLM/CBLH.
13. Confirm that the red STATUS LED for the back end module is off.
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14. Connect the new SAS cables to the back end module on the CBLM or
CBLH and to the ENC of the drive tray connected to the CBLM or CBLH.
 

 
15. Connect the cables to the SAS adapters. When replacing the SAS adapter

for SAS cable DW-F800-SCQ1HA, install the cable into a new SAS
adapter, and then connect it to the ENC.

Note: When connecting the SAS cable DW-F800-SCQ1HA, be sure
the cable latch clicks and the cables are connected securely to the
SAS adapters.

16. Route the cables appropriately.
17. At the Replace Disk Board window, click Restore.

A progress bar shows the replacement status.
18. When the progress bar goes away and the completion message appears,

click Close.
19. Click the DKBs tab, and then check that the back end module whose

SAS cable to replaced is Normal.
20. Log out and close the Maintenance Utility window.

Replacing SAS cables on a drive tray
Replacing SAS cables for a drive tray requires you to block an ENC before
replacing the cables.

The following procedure describes how to replace SAS cables connected to a
drive tray. Wear a wrist strap connected to the storage system to prevent
part failures caused by static electricity. Do not remove the wrist strap until
you finish the procedure.
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Procedure

1. Start the maintenance utility.
2. Click Hardware > Drive Box.
3. In the Drive Box window, click the ENCs tab.
4. Click the ENC whose SAS cable you want to replace, and then click

Replace.
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5. When the Replace ENC window appears, confirm that the ENC shown in
the window is the one to be replaced.
 

 
6. Click Block.
7. Verify that the appropriate ENC is blocked.
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8. Leave the Replace ENC window open, but do not click the Restore
button.
 

 
9. Confirm that the red ALARM LED on the ENC whose SAS cable you want to

replace is on.
10. Unroute the SAS cable connected to the drive tray.

Note: For SAS cable DW-F800-SCQ1HA, you do not have to
unroute the cable.

11. Remove the SAS cable from the ENC on the drive tray and from the ENC
on a drive tray connected to another drive tray.
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12. For SAS cable DW-F800-SCQ1HA:
a. Remove the cable from the SAS adapters you want to replace.
b. Pull the latch of the cables and remove them from the SAS adapters.
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13. Connect new SAS cables to the ENC on the drive tray(s).

Note: When connecting the SAS cable DW-F800-SCQ1HA, be sure
the cable latch clicks and that the cables are connected securely to
the SAS adapters.

 

 
14. Confirm that the red ALARM LED for the ENC is off.
15. Route the cables appropriately.
16. At the Replace ENC window, click Restore.

A progress bar shows the replacement status.
17. When the progress bar goes away and the completion message appears,

click Close.
18. Click the ENCs tab, and then check that the ENC whose SAS cable to

replaced is Normal.
19. Log out and close the Maintenance Utility window.
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Replacing cache flash memory

Before replacing cache flash memory (CFM), read the precautions and
understand the procedure for your CFM.

□ Blocking the CFM

□ Replacing the CFM

□ Restoring a CFM
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Blocking the CFM

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. In the Controller Chassis window, click the CFMs tab.
4. Confirm that the status of the CFM to be replaced is Warning.

 

 
5. Click the CFM to be replaced, and then click Replace.
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6. When the Replace Cache Flash Memory window appears, confirm that
the CFM shown in the window is the one to be replaced, and then
clickBlock.
 

 
7. Click Block.
8. Verify that the CFM is blocked and is ready for replacing.
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9. Leave the Replace Cache Flash Memory window open, but do not click
the Restore button.
 

 

Replacing the CFM

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• Use the maintenance utility to block the CFM.
• The red STATUS LED for the CFM to be replaced is on.
• The red ALARM LED (CBSS/CBSL) or ALM LED (CBLM/CBLH) on the cache

flash memory (CFM) to be replaced is on.

Procedure

1. Loosen the blue screw securing the CFM.
2. Open the lever
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3. Hold the CFM with both hands, and then pull it gently and remove it.
 

 
 

 
4. With the lever opened completely, insert the new CFM all the way into

the slot.
5. Close the lever completely, and tighten the blue screw to secure the CFM.
6. Confirm that the red ALARM or ALM LED on the CFM is off.

Postrequisites
• Use the maintenance utility to restore (unblock) the CFM.
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Restoring a CFM
In the maintenance utility:

Procedure

1. In the Replace Cache Flash Memory window, click Restore.
A progress bar shows the replacement status.

2. When the progress bar goes away and the completion message appears,
clickClose.

3. Click the CFMs tab in the Controller Chassis window.
4. Verify that the status of the new CFM is Normal.

If necessary, click Refresh at the top-right of the window to update the
status of the window.

5. Log out and close the Maintenance Utility window.
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Replacing a LAN blade

Before replacing a LAN blade, read the precautions and understand the
procedure for your LAN blade.

□ Blocking the controller

□ Replacing the LAN blade

□ Restoring the LAN blade
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Blocking the controller

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. In the Controller Chassis window, click the LANBs tab.
4. Confirm that the status of the LAN blade to be replaced is Warning.

 

 
5. Click the CTLs tab.
6. Click the Replace list and select the controller that contains the LAN

blade to be replaced.
7. When the Replace Controller Board window appears, confirm that the

controller shown in the window is the one that contains the LAN blade to
be replaced.

188 Replacing a LAN blade
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



8. Click Block.
 

 
9. Confirm that the controller is blocked.
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10. Leave the Replace Controller Board window open, but do not click the
Restore button.
 

 
11. Confirm that the red CTL ALM LED on the controller is on.

Replacing the LAN blade

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• Use the maintenance utility to block the LAN blade.

• The red CTL ALM LED on the CBLM or CBLH controller is on.

Procedure

1. Remove the LAN cable from the user LAN port.
2. Release the controller:

a. Loosen the blue right and left screws on the lever of the controller to
be replaced.
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b. Open the lever.
3. Loosen the blue screw that secures the LAN blade.
4. Using both hands, pull out and remove the LAN blade.
5. Insert the new LAN blade into the slot, just before the "shield finger."

 

 
6. Gently push the new LAN blade all the way into the slot.
7. Tighten the blue screw to secure the LAN blade.

 

 
8. Secure the controller.

a. Push in the controller all the way until the right and left levers close
completely.

b. Tighten the blue screw and secure the controller.
9. Confirm that the red CTL ALM LED on the controller is off.

10. Connect the LAN cable you removed to the user LAN port.

Postrequisites
• Use the maintenance utility to restore (unblock) the LAN blade.

Restoring the LAN blade
In the maintenance utility:
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Procedure

1. In the Replace Controller Board window, click Restore.
A progress bar shows the replacement status.

Note: The restore operation can take up to 20 minutes to
complete. If a message states that the recovery failed, go to the
HDS Support Portal at https://portal.hds.com.

2. When the progress bar goes away and the completion message appears,
click Close.

3. Click the LANBs tab in the Controller Chassis window and confirm that
the status of the new LAN blade is Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

4. Confirm that the red CTL ALM LED is off at the controller that contains
new LAN blade.

5. Log out and close the Maintenance Utility window.
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Replacing a backup module

Before replacing a backup module, read the precautions and understand the
procedure for the backup module.

□ Replacing a BKM

□ Replacing a BKMF
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Replacing a BKM
The following sections describe how to replace a BKM backup module.

Checking the BKM backup module

Prerequisites
• A backup module is installed in the backup module enclosure.
• Storage system power is turned on.
• The red STATUS LED on the backup module to be replaced is on.
• Use the Detail Dump tool to collect the storage system information.

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. Click the BKMs tab.

 

 
4. Confirm that the status of the backup module to be replaced isWarning.

Replacing the BKM backup module

Use the following procedure to replace the BKM backup module.
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Procedure

1. Loosen the blue screw that secures the BKM.
2. Open the lever forward.
3. Using both hands, hold the body of the BKM, and then pull out and

remove the BKM.
4. With the lever of the BKM opened forward, insert the new BKM into the

slot.
 

 
5. Push the BKM all the way into the slot.
6. Close the lever and tighten the blue screw to secure the BKM.
7. Confirm that the green STATUS LED on the BKM is blinking.
8. In the BKMS tab of the maintenance utility, check that the status of the

BKM you replaced is Normal.
9. Log out and close the Maintenance Utility window

Replacing a BKMF
The following sections describe how to replace a BKMF backup module.

Blocking a BKMF

Prerequisites
• A backup module is installed in the backup module enclosure.
• Storage system power is turned on.
• The red STATUS LED on the backup module to be replaced is on.
• Use the Detail Dump tool to collect the storage system information.
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Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. Click the BKMFs tab.

 

 
4. Confirm that the status of the backup module to be replaced is Warning.

Replacing the BKMF backup module

Prerequisites
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Storage system power is turned on.
• The red STATUS LED on the backup module to be replaced is on.
• Use the Detail Dump tool to collect the storage system information.
• Use the maintenance utility to verify the backup module status.

Procedure

1. Loosen the blue screw that secures the backup module.
2. Open the lever forward.
3. Open the lever.
4. Hold the backup module with both hands, and then pull it out and

remove it.
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5. Hold the latch of the cable connector of the battery to be installed in the
backup module and remove the connector from the socket.

6. Remove all batteries that are installed.
A maximum of two batteries can be installed.

7. Loosen the blue screw on the rear side of the new backup module.
8. Slide the top panel of the new backup module and remove it.
9. In the new backup module, install all batteries you removed and route

the cables along the groove of the backup module.
If you removed one battery, install the battery in the front (fan side) of
the storage system. Route the cables to avoid bending the cables.

10. Connect the cable connector to the socket.
11. Slide the top panel of the backup module and attach it.
12. Tighten the blue screw on the rear panel of the backup module.
13. With the lever of the backup module opened forward, insert the new

backup module into the slot.
 

 
14. Push all the way into the slot.
15. Close the lever and tighten the blue screw to secure the backup module.
16. Confirm that the green STATUS LED on the BKMF is blinking.
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17. In the BKMFs tab of the maintenance utility, check that the status of the
backup module you replaced is Normal.
If necessary, click Refresh at the top-right of the window to update the
status.

18. Log out and close the Maintenance Utility window.
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General maintenance

This chapter provides general maintenance procedures.

□ Periodic maintenance

□ Cleaning the storage system

□ Inspecting fans

□ Replacing the battery

□ Checking for loose or damaged cables or connectors

□ Restarting the storage system

□ Storing the storage system
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Periodic maintenance
The following table describes the periodic maintenance procedures you can
perform to extend the life of your storage system. Inspect and clean the
storage system regularly according to the operation environment.

Maintenance Interval
Approximate time to perform

procedure

Clean the storage system Once a year 5 minutes

Inspect the fan Once a year 5 minutes

Replace the battery Every 3 years 10 minutes

Cleaning the storage system
When cleaning the storage system, check whether the system's air vents are
clogged by dust. If they are clogged, remove the dust with a vacuum cleaner
or wipe the dust using a dry cloth.

Keep the front bezel and rear panel clean. Otherwise, storage system
ventilation deteriorates and the inside temperature might rise, causing a
failure or fire.

Do not move the storage system during cleaning.

Procedure

1. Clean the outside of the front bezel.
2. Insert the key in the front bezel and turn in the direction shown by the

arrow to unlatch the bezel.

Caution: Attach or remove the front bezel carefully to avoid
pinching your fingers. Do not touch "live parts;" otherwise, you
can receive an electric shock.

3. Remove the front bezel.
4. Clean the internal surfaces of the front bezel.
5. Attach the front bezel.
6. Turn the key in the direction shown by the allow to latch the front bezel.
7. Clean the external surfaces of the rack.

Inspecting fans
Inspect the fans when storage system power is turned on.
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Caution: Storage system fans rotate at high speed. Exercise extreme caution
to avoid getting anything caught in the fan and to prevent injury.

Procedure

1. Gain access to the inside of the rack.
2. Open the front bezel of the storage system.
3. Confirm that the storage system fans are rotating
4. Close the front bezel, and then close the rack.

Replacing the battery
Each controller contains a sealed battery that provides backup power to
cache memory. You must replace the battery every three years.

Note: Do not disassemble the battery; otherwise, you could get burned or
receive a shock.

If the storage system does not receive power for more than six months, the
battery can become discharged and possibly damaged. To avoid this
situation, charge the battery for more than three hours at least once every
six months.

Checking for loose or damaged cables or connectors
It is good practice to check cables for damage on a periodic basis. Confirm
that all cables and cable connectors are in good condition and connected
securely to the appropriate interfaces.

Restarting the storage system
Before restarting the storage system, wait at least one minute with the main
switch off (amber POWER LED is off).

Storing the storage system
If the storage system does not receive power for more than six months, the
battery can become discharged and possibly damaged. To avoid this
situation, charge the battery for more than three hours at least once every
six months.

Note: Do not store the equipment in an environment with temperatures of
104ºF (40ºC) or higher because battery life will be shortened.
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Troubleshooting

This chapter covers troubleshooting topics related to the replacement of
components.

□ General troubleshooting

□ Troubleshooting Hitachi Device Manager - Storage Navigator

□ Dump tool

□ Troubleshooting the maintenance utility

□ Checking alerts

□ Turning the storage system on or off using the maintenance utility

□ Using LEDs to diagnose problems
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General troubleshooting

Correct values for the storage system IP address
Set appropriate value IP address, subnet mask, and default gateway settings
for the storage system for the customer environment.

IPv4 default value
Controller 1:
Controller 2:
IP Address: 192.168.0.16
Subnet Mask: 255.255.255.0
Default gateway: 0.0.0.0
Controller board #2:
IP Address: 192.168.0.17
Subnet Mask: 255.255.255.0
Default gateway: 0.0.0.0

IPv6 default value
Controller 1:
IP Address: Auto
Controller 2:
IP Address: Auto

DHCPv4 configuration for storage systems
If the storage system is configured to use DHCPv4, connect with the IP
address assigned by the DHCPv4 server. When using DHCPv4 server,
configure the storage system to use a static IP address.

If the storage system does not receive an IP address from a DHCP server
when it is configured for DHCP, Hitachi Device Manager - Storage Navigator
cannot connect to the storage system. Contact your network administrator,
and review the DHCPv4 server settings.

Default value
DHCPv4: Off (Static IP Address)

IP address being used by other storage systems or hosts
If the storage system is using the same IP address is used by other devices,
Hitachi Device Manager - Storage Navigator cannot connect to the storage
system. Assign an IP address to the storage system that is not used by
another device.
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IP address configuration for the host
Use Hitachi Device Manager - Storage Navigator to set the IP address, subnet
mask, and default gateway that the host can use to communicate with the
storage system.

TCP/UDP port filtering being performed on the network switch
The default TCP port number for Hitachi Device Manager - Storage Navigator
is 2000. Set an appropriate value for the customer's environment.
[default port number]: 2000 (standard)
28355 (secure)
Change the port number in environments that use Cisco SIP Phones.

Search Storage system performed across the IPv6 routers
The Auto Search Storage system of IPv6 uses link-local scope multicast. The
IPv6 router is unable to transfer this multicast to other local links, so the IPv6
router is unable to search storage systems across the IPv6 router. For
different local links, register the storage system using a static IP address
search.

Troubleshooting Hitachi Device Manager - Storage
Navigator

Message ID Description Recovery Action

21542 005011 Clicking the Apply button
in the Add System
window caused the error,
and the storage icon is not
created.

The SVP does not have sufficient free
space to create the storage icon. Make
20 GB or more of free space available in
the installation directory of the drive.

21542 005019 Clicking Start Service
caused the error, and the
service cannot start.

Two or more services cannot be executed
simultaneously. Stop the service that
started before starting the other service.

21542 005026 Clicking Start Service
caused the error and the
service cannot start.

The SVP IP address is invalid. At the top-
right of the screen of the Storage
Device List window, click SVP IP
Address. In the Change SVP IP
Address window, set the IP address of
the SVP, and then retry Start Service.

21542 005026 The status of the service
changed to Error after
rebooting the SVP with the
Start-up service set to
Auto. The Service Status
window shows the error,
and the Status field shows
BASE.

The SVP IP address is invalid. At the top-
right of the screen of the Storage
Device List window, click SVP IP
Address. In the Change SVP IP
Address window, set the IP address of
the SVP, and then retry Start Service.
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Message ID Description Recovery Action

21041-006002 Clicking the storage
system in the Storage
Device List window
caused the error, and
Hitachi Device Manager -
Storage Navigator cannot
start.

The default browser is not defined.
Specify your browser as the default
browser (refer to the documentation for
your browser) and retry.

21041-006005 Starting the Storage
Device List caused the
error, and the Storage
Device List cannot start.

Failed to connect to the Supervisor
service (DKCMan/MAPPAppServer/
MAPPWebServer). Select Control Panel >
Administrative Tools > Services in
Windows, and confirm that the DKCMan,
MAPPAppServer, and MAPPWebServer
services started. Start the Storage Device
List again.

If the status of DKCMan, MAPPAppServer,
and MAPPWebServer did not start, right-
click the service and select Start, or
reboot the SVP.

Dump tool

About the Dump tool
Use the Dump tool to collect Hitachi Device Manager - Storage Navigator
configuration information.

You can use the collected dump files:
• Before deleting the storage management software.
• To collect the dump files from the SVP.
• To troubleshoot using Device Manager - Storage Navigator.
• To check the Device Manager - Storage Navigator configuration. In Device

Manager - Storage Navigator, click File > Refresh All to update the
configuration information, and then use the Dump tool to collect dump
files.

The Dump tool has two files.
• Dump_Normal.bat            collects dump files containing information

about the SVP and minimum information about the storage system. Use
this tool when there is no fatal error, such as a problem with accessing
Device Manager - Storage Navigator.

• Dump_Detail_bat collects detailed dump files and contains comprehensive
information about the storage system in addition to the contents of the
normal dump file. Use this tool if you cannot start Device Manager -
Storage Navigator or to check for problems with the storage system.
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Using the Dump tool

Prerequisites

• The client PC must be connected to the SVP using the Remote Desktop
Connection.

• No other user should be using the Dump tool.
• No maintenance operation is being performed.

Procedure

1. Close all Hitachi Device Manager - Storage Navigator sessions on the
SVP.

2. On the SVP, exit to a Windows command prompt as Administrator.
3. Change to the directory where the Dump tool is located.

For example, C:\Mapp\wk\83xxxxxxx\DKC200\mp\pc where 83xxxxxxx is
the DKC serial number.

4. Specify the output folder for the dump file (for example, C:\Mapp\wk
\83xxxxxxx\DKC200\tmp) as an output destination, and then execute
Dump_Normal.bat or Dump_Detail.bat.

5. When the completion message appears, close the command prompt.
6. Under the output destination folder, check that the following files are

created.:
• hdcp.tgz = dump file

zSv_AutoDump.log = dump tool log file. If the dump file was not
created, give this log file to your administrator. Otherwise, delete the
log file.

7. Exit the command prompt.

Collecting dump files manually
If you cannot use the Dump tool or the Dump tool fails, collect the following
dump files manually.

Note: In the following list:
• installDir = the SVP installation directory (for example, C:\Mapp).
• %USERPROFILE% = the installation login user of the SVP (for example, C:

\Users\<user name>).
• %WINDIR% = the Windows folder in the system drive (for example, C:

\Windows).

<installDir>\wk\supervisor\dkcman\log\*.*
<installDir>\wk\supervisor\dkcman\cnf\*.*
<installDir>\wk\supervisor\rmiserver\log\*.*
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<installDir>\wk\supervisor\rmiserver\cnf\*.*
<installDir>\wk\supervisor\sdlist\log\*.*
<installDir>\wk\supervisor\mappiniset\logs\MappIniSet\*.*
<installDir>\OSS\apache\logs\*.log
<installDir>\OSS\apache\logs\ssl\*.log
<installDir>\OSS\jetty\logs\*.log
%USERPROFILE%\AppData\LocalLow\Sun\Java\Deployment\log
%WINDIR%\system32\config\SysEvent.Evt
%WINDIR%\system32\config\SecEvent.Evt
%WINDIR%\system32\config\AppEvent.Evt
%WINDIR%\minidump\*.dmp
%WINDIR%\System32\Winevt\Logs\Application.evtx
%WINDIR%\System32\Winevt\Logs\Security.evtx
%WINDIR%\System32\Winevt\Logs\System.evtx
%WINDIR%\system32\drivers\etc\HOSTS*
%WINDIR%\system32\drivers\etc\services*
%WINDIR%\minidump\*.dmp
c:\SetupTrace\*.*

Troubleshooting the maintenance utility

JavaScript security
The Maintenance Utility window opens, but it is blank, even after one or
more minutes elapse.

Use the following procedure to add the Maintenance Utility window to the
trusted sites, and then open the Maintenance Utility window again.

Procedure

1. In Internet Explorer, select Tools > Internet Options and select the
Security tab.

2. Click Trusted Sites > Sites.
3. Clear the Require server verification (https:) for all sites in this

zone check box.
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4. Enter the IP address of controller 1 to Add this website to the zone
and click Add.

5. Add the IP address of controller 2 using the same method.
6. Click Close.
7. When returning to the Internet Options window, click OK to close the

window.

Compatibility view
Contents displayed in the Maintenance Utility window may be corrupted.
Exclude the maintenance utility from the compatibility view target. In
Internet Explorer, check the Compatibility View on the address bar. In
Internet Explorer versions 10 and earlier:

Procedure

1. Select Tools > Compatibility View setting.
2. Clear the Display intranet sites in Compatibility View and the

Display all websites in Compatibility View check box.
3. Click Close.

Clearing the browser cache
In the unlikely event that the login to the Maintenance Utility window fails,
or the Maintenance Utility window opens but is blank, even after one or
more minutes elapse, clear the browser cache and open the Maintenance
Utility window again.

Forcing browser refreshes of the Maintenance Utility window
If images in the Maintenance Utility window do not appear properly,
refresh your web browser.

To refresh your web browser:

Procedure

1. If the maintenance utility is open, log out.
2. Press the Ctrl key and F5 key at the same time to force a refresh.

Maintenance Utility window hangs
The maintenance utility provides a locking feature you can use in case the
window freezes (or "hangs").

In the unlikely event that the Maintenance Utility window "hangs" during
normal operation:

Procedure

1. Check the network connection between the SVP and the storage system.
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2. Log out of the SVP, and then log in again.
3. When the System Locked message appears, click System Locked to

unlock the system.

Checking alerts

If an alert, warning, or information item appears in the maintenance utility,
but there is no service information message (SIM) associated with it, use the
following procedure to obtain more information about the item.

Procedure

1. In the navigation area of the Maintenance Utility window, check the
status of the storage system.
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2. In the header area, click Alert.
The Alerts tab appears.

 

 

Status Description Navigation area Alert color

Failed The storage system

might be down.

 

 

Red

Warning A part has a Blocked,

Failed, or Warning

status.

 

 

Amber

Information Alert does not have a

SIM defined for it.

 

 

Amber

Ready All parts have a normal

status.

 

 

Green

Power-on in progress Power-on is in

progress.

 

 

—

Power-off in progress Power-off is in

progress.

 

 

—
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Status Description Navigation area Alert color

Unknown The storage system is

in an unknown state

prior to power on..

 

 

—

3. In the Alerts tab, click DKC and GUM, and then check the alerts.
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4. Under the Alert ID column, click an entry.
The Alert Detail window appears.

 

 
5. To check the internal alert, click Internal Alerts (DKC) or Internal

Alerts (GUM) from the View Internal Alerts list. Click an entry under
Alert ID.
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6. When the Alert Detail window appears, check the alert information:
• SSB shows high-priority error information.
• SSBS = shows low-priority error information.

SSB Tab in the Internal Alerts (DKC) Window
 

 
SSBs Tab in the Internal Alerts (DKC) Window
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Internal Alerts (GUM) Window
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Turning the storage system on or off using the maintenance
utility

In the unlikely event the SVP will not run or it cannot connect to the storage
system, you can power on and off the storage system using the maintenance
utility.

Prerequisites

• The breaker is turned on.
• The amber POWER LED on the storage system is on.

Procedure

1. Start the browser on the client PC.
2. In the browser address bar, enter the address of controller 1, and press

Enter.
The login window opens.

3. Log in.
The Maintenance Utility window opens.

4. To power on the storage system, select Power Management > Power
on Storage System. When the confirmation message appears, click
Submit.

5. To power off the storage system, select Power Management > Power
off Storage System. When the confirmation message appears, click
Submit.

Using LEDs to diagnose problems
If the storage system used in a remote TrueCopy configuration restarts with
the TrueCopy status of enabled, the following occur:
• The path used by TrueCopy becomes blocked. Notifications from the

Hitachi Device Manager - Storage Navigator email alert function, SNMP
Agent Support function, and TRAP occur when the path is blocked. Follow
the instructions in the notification. The blocked path recovers
automatically after restarting the storage system.

• If the TrueCopy pair status is PAIR or COPY, the pair changes to PSUE. In
this case, suspend the paris before restarting the storage system.

POWER LED does not go on

Procedure

1. Set the main switch to on.
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2. Is the POWER LED on at the controller?
• Yes: Go to step 10.
• No: Power on the host computer.

3. Is the POWER LED on at the controller?
• Yes: Go to step 10.
• No: Set the main switch to off.

4. Check that the PDU on the rack is delivering power to the storage
system.

5. Verify that the AC cable is correctly connected to the plug socket and the
equipment.

6. Set the main switch to on.
7. Is the POWER LED on at the controller?

• Yes: Go to step 10.
• No: Set the main switch to off.

8. Contact your administrator. Go to step 10.
9. Is the READY LED on?

• Yes: Continue to use the equipment, even if the green READY LED
blinks fast.

• No: See READY LED does not go on or READY LED went on and then off.
10. End of procedure.

POWER LED turned off

Procedure

1. Is AC power being supplied?
• Yes: Go to step 2.
• No: Supply AC power to the storage system and restart the storage

system. Go to step 2.
2. Set the main switch to off.
3. Wait over a minute and then set the main switch to on.
4. Is the POWER LED on at the controller?

• Yes: go to step 6.
• No: set the main switch to off.

5. Contact your administrator. Go to step 7.
6. Is the READY LED on at the controller?

• Yes: Use the equipment in its current operational state, even if the
green READY LED blinks fast.

• No: See READY LED does not go on or READY LED when on and then
off.

7. End of procedure.
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READY LED does not go on or READY LED went on and then off

Procedure

1. Is the controller POWER LED on?
• Yes: Go to step 2.
• No: Go to step 4 in POWER LED does not go on.

2. Is the ALARM LED on at the controller?
• Yes: See ALARM LED is on.
• No: Go to step 3.

3. Turn off the main switch.
4. Wait more than one minute and then set the main switch to on.
5. Is the READY LED on at the controller?

• Yes: Continue to use the equipment. If the green READY LED blinks
fast, the storage system is operational. Go to step 8.

• No: Go to step 8.
6. Set the main switch to off.
7. Contact your system administrator.
8. End of procedure.

ALARM LED is on.

Procedure

1. Identify which components failed.
2. Contact your system administrator and do not disturb the equipment.

WARNING LED goes on or blinks.

Procedure

1. Does the amber WARNING LED on the controller blink fast?
• Yes: Identify which components in the controller chassis failed using

Hitachi Device Manager - Storage Navigator. Go to step 5.
• No: Go to step 2.

2. Does the amber WARNING LED at the controller blink slowly?
• Yes: At the controller, wait for the amber WARNING LED to go off and

the green READY LED to go on.
• No: Go to step 3.

3. Is the green READY LED at the controller on?
• Yes: Go to step 5.
• No: See READY LED does not go on or READY LED went on and then off

4. Continue to use the equipment and contact your system administrator.
5. End of procedure.
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A
Warning labels on the storage system

□ CBSS controller

□ CBSL controller

□ CBLM controller

□ Small form factor drive tray

□ Large form factor drive tray

□ Flash module drive tray

□ Dense intermix drive tray

□ CBSS/CBSL controller

□ CBLM controller

□ Drive for a CBSS/small form factor drive tray

□ Drive for a small form factor drive tray

□ Drive for a CBSL/large form factor drive tray

□ Drive for a large form factor drive tray

□ Drive for a flash module drive tray

□ Drive for a dense intermix drive tray

□ CBSS/CBSL power unit
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□ CBLM power supply

□ Power supply for small and large form factor drive trays

□ Flash module drive tray power supply

□ Dense intermix drive tray power supply

□ Front end module (Fibre Channel/iSCSI)

□ Back end module

□ ENC for small and large form factor drive trays

□ ENC for a dense intermix drive tray

□ CMA (used to secure dense intermix drive tray)

□ Battery
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CBSS controller
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CBSL controller
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CBLM controller
 

 

Small form factor drive tray
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Large form factor drive tray
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Flash module drive tray
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Dense intermix drive tray
 

 

CBSS/CBSL controller
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CBLM controller
 

 

Drive for a CBSS/small form factor drive tray
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Drive for a small form factor drive tray
 

 

Drive for a CBSL/large form factor drive tray
 

 

Drive for a large form factor drive tray
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Drive for a flash module drive tray
 

 

Drive for a dense intermix drive tray
 

 

CBSS/CBSL power unit
 

230 Warning labels on the storage system
Hitachi Virtual Storage Platform G200, G400, G600 Service Guide



 

CBLM power supply
 

 

Power supply for small and large form factor drive trays
 

 

Flash module drive tray power supply
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Dense intermix drive tray power supply
 

 

Front end module (Fibre Channel/iSCSI)
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Back end module
 

 

ENC for small and large form factor drive trays
 

 

ENC for a dense intermix drive tray
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CMA (used to secure dense intermix drive tray)
 

 

Battery
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